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Accessibility Statement

BCcampus Open Education believes that education must be available to everyone which means supporting the creation of free, open, and accessible educational resources. We are actively committed to increasing the accessibility and usability of the textbooks we produce.
 Accessibility features of the web version of this resource
 The web version of Key Concepts of Computer Studies has been designed with accessibility in mind by incorporating the following features:
 	It has been optimized for people who use screen-reader technology. 	all content can be navigated using a keyboard
 	links, headings, and tables use proper markup
 	all images that convey information have text descriptions
 
 
 	Information is not conveyed by colour alone.
 
 Other file formats available
 In addition to the web version, this book is available in a number of file formats, including PDF, EPUB (for eReaders), MOBI (for Kindles), and various editable files. Here is a link to where you can download this book in another file format. Look for the “Download this book” drop-down menu to select the file type you want.
 This book occasionally links to external websites. For those using a print copy of this resource, the link text is underlined, and you can find the web addresses for all links in parentheses.
 Known accessibility issues and areas for improvement
 While we strive to ensure that this resource is as accessible and usable as possible, we might not always get it right. Any issues we identify will be listed below.
 There are currently no known issues.
 Accessibility standards
 The web version of this resource has been designed to meet Web Content Accessibility Guidelines 2.0, level AA. In addition, it follows all guidelines in Appendix A: Checklist for Accessibility. The development of this toolkit involved working with students with various print disabilities who provided their personal perspectives and helped test the content.
 Let us know if you are having problems accessing this resource
 We are always looking for ways to make our resources more accessible. If you have problems accessing this resource, please contact us to let us know so we can fix the issue.
 Please include the following information:
 	The location of the problem by providing a web address or page description
 	A description of the problem
 	The computer, software, browser, and any assistive technology you are using that can help us diagnose and solve your issue 	e.g., Windows 10, Google Chrome (Version 65.0.3325.181), NVDA screen reader
 
 
 
 You can contact us one of the following ways:
 	Contact form:  BCcampus OpenEd Help
 	Web form: Report an Error
 
 This statement was last updated on November 27, 2020. 
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For Students: How to Access and Use this Book

This textbook is available in the following formats:
 	Online webbook. You can read this book online on a computer or mobile device in one of the following browsers: Chrome, Firefox, Edge, and Safari.
 	PDF. You can download this book as a PDF to read on a computer (Digital PDF) or print it out (Print PDF).
 	Mobile. If you want to read this textbook on your phone or tablet offline, you can use the EPUB (eReader) or MOBI (Kindle) files.
 	HTML. An HTML file can be opened in a browser. It has very little style so it doesn’t look very nice, but some people might find it useful.
 
 You can access the online webbook and download any of the formats for free here: Key Concepts of Computer Studies. To download the book in a different format, look for the “Download this book” drop-down menu and select the file type you want.
 How can I use the different formats? 	Format 	Internet required? 	Device 	Required apps 	Features 	Screen reader compatible 
 	Online webbook 	Yes 	Computer, tablet, phone 	An internet browser (Chrome, Firefox, Edge, or Safari) 	Option to enlarge text and compatible with browser text-to-speech tools. 	Yes 
 	PDF 	No 	Computer, print copy 	Adobe Reader 	Ability to zoom in, highlight, and annotate the text. 	Unsure 
 	EPUB and MOBI 	No 	Computer, tablet, phone 	Kindle app (MOBI) or eReader app (EPUB) 	Option to enlarge text, change font style, size, and colour. 	Unsure 
 	HTML 	No 	Computer, tablet, phone 	An internet browser (Chrome, Firefox, Edge, or Safari) 	Option to enlarge text and compatible with browser text-to-speech tools. 	Yes 
  
 Tips for Using This Textbook
 	Search the textbook. 	If using the online webbook, you can use the search bar in the top right corner to search the entire book for a key word or phrase. To search a specific chapter, open that chapter and use your browser’s search feature by hitting [Cntr] + [f] (PC) or [Command] + [f] (Mac).
 	The [Cntr] + [f] and [Command] + [f] keys will also allow you to search a PDF, HTML, EPUB, and MOBI files if you are reading them on a computer.
 	If using an eBook app to read this textbook, the app should have a built-in search tool.
 
 
 	Navigate the textbook. 	This textbook has a table of contents to help you navigate through the book easier. If using the online webbook, you can find the full table of contents on the book’s homepage or by selecting “Contents” from the top menu when you are in a chapter.
 
 
 	Annotate the textbook. 	If you like to highlight or write on your textbooks, you can do that by getting a print copy, using the Digital PDF in Adobe Reader, or using the highlighting tools in eReader apps.
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About BCcampus Open Education

Key Concepts of Computer Studies by Meizhong Wang was funded by BCcampus Open Education.
 BCcampus Open Education began in 2012 as the B.C. Open Textbook Project with the goal of making post-secondary education in British Columbia more accessible by reducing students’ costs through the use of open textbooks and other OER. BCcampus supports the post-secondary institutions of British Columbia as they adapt and evolve their teaching and learning practices to enable powerful learning opportunities for the students of B.C. BCcampus Open Education is funded by the British Columbia Ministry of Advanced Education, Skills & Training, and the Hewlett Foundation.
 Open educational resources (OER) are teaching, learning, and research resources that, through permissions granted by the copyright holder, allow others to use, distribute, keep, or make changes to them. Our open textbooks are openly licensed using a Creative Commons licence, and are offered in various e-book formats free of charge, or as printed books that are available at cost.
 For more information about open education in British Columbia, please visit the BCcampus Open Education website. If you are an instructor who is using this book for a course, please fill out our Adoption of an Open Textbook form.
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Preface

If you are looking for a quick study guide in Computer Studies, Key Concepts of Computer Studies is an excellent resource. Skip the lengthy and distracting books and instead use this book to guide your studies, reviewing, or tutoring. This book quickly gets to the heart of each particular topic, helping students with a quick review before doing homework. It also supports preparation for tests.
 This book was designed for fundamental and intermediate levels in computer studies. It is concise, understandable, and effective.
 Key Features
 As an aid to readers, the book provides some noteworthy features:
 	Key terms, definitions, phrases, concepts, etc. are easily located.
 	Clear step-by-step instructions.
 	Clear and easy-to-understand written format and style. Materials presented in visual and gray scale format.
 	Self-tests at the end of each unit test students’ understanding of the material. Students can take the self-test before beginning the unit to determine how much they know about the topic. Those who do well may decide to move on to the next unit.
 
 Suitable Readers
 This book can be used by:
 	Adult Basic Education (ABE) programs at colleges.
 	Students at community colleges or high schools.
 	Self-study readers.
 	Professionals as a quick review of some basic computer skills.
 	Anyone else with an interest in the topic.
 
 Acknowledgements
 Special thanks to Krista Lambert, Program Manager, Health, ECE, & ABE ZTC Programs, BCcampus, for her help, advice, and support throughout the entire process.
 I would also like to express my sincere gratitude to Josie Gray, Kaitlyn Zheng, Arianna Cheveldave, and Harper Friedman at BCcampus for their help, accuracy in proofreading and laying out the book, and support in publishing this book.
 





SECTION I - FUNDAMENTAL COMPUTER STUDIES

Section I covers the following topics:
 	Unit 1. Basic knowledge and common uses of computers
 	Unit 2. Keyboarding
 	Unit 3. Basic file management and word processing
 	Unit 4. Using web search engines
 	Unit 5. Electronic communication
 
 




Unit 1. Basic knowledge and common uses of computers

Topic A: Basic knowledge of computers
 	[image: ]System unit
 	Basic parts of a computer system
 	Hard drive, USB drive, and printer
 
 Topic B: Start a computer system or program
 	Start and shut down a computer system
 	Start a program
 	Close a program
 
 Topic C: Online communication
 	Email and video conferencing
 	Social networking
 
 Topic D: Common uses of computers in society
 	Computers at home
 	Computers in education and business
 	Computers in healthcare and science/engineering
 
 Unit 1 Self-test
 




Topic A: Basic knowledge of computers

Click play on the following audio player to listen along as you read this section.
 [image: Thumbnail for the embedded element "Unit 1 Topic A: Basic knowledge of computers"] A BCcampus element has been excluded from this version of the text. You can view it online here: https://opentextbc.ca/computerstudies/?p=61 
 
 System Unit
 [image: ]System unit – the main part of a desktop computer (the case) that contains all of the main electronic components of a computer.
 	Other common names of the system unit: tower, chassis, or main unit.
 	A system unit includes the motherboard, CPU (Central Processing Unit), RAM (Random-Access Memory), hard drive, expansion cards, power supply, etc.
 	A system unit does not include peripheral devices, such as keyboard, mouse, monitor, printer, etc.
 	The term system unit is used to distinguish between the computer and its peripheral devices (keyboard, mouse, monitor, printer, scanner, etc.).
 
 [image: ]
 Motherboard (mainboard) – the main circuit board of the computer.
 	The motherboard is the system core of a computer.
 	The motherboard is a computer’s central structure that connects the different parts of a computer together.
 	Whole computer system is connected, managed, and controlled by the motherboard.
 
 [image: ]
 CPU (Central Processing Unit) – CPU is often referred to as the brain or engine of a computer where most of the processing and operations take place.
 	Other common names of the CPU: main processor, central processor, etc.
 	The CPU is the primary component of a computer that executes, interprets, and carries out all instructions.
 
 [image: ]
 RAM (Random-Access Memory) – a type of data storage (memory element) used in computers that temporarily stores programs and data.
 	RAM only holds onto data and programs while the computer is on.
 	All information that was stored in RAM is erased when the computer is turned off.
 
 Basic Parts of a Computer System
 A computer system includes a system unit along with all its software (such as Office 2016, Windows 10, etc.) and peripheral devices (such as a mouse, keyboard, monitor, printer, etc.) connected to it.
 [image: ]
 Computer monitor – a display screen used to display information (text, image, video, etc.) processed by a computer.
 [image: ]
 Keyboard – an input device (the set of typewriter-like keys) that allows a user to enter characters (letters, numbers, symbols, etc.) into a computer.
 [image: .]
 Mouse – a hand-held pointing device that can control the position of a cursor (pointer) on a display screen.
 [image: ]
 Trackpad (or touchpad) – a small flat surface on a laptop or other computer that does the same things as a mouse (a trackpad is a built-in mouse).
 [image: ]
 Hard Drive, USB Drive, and Printer
 Hard disk drive (HDD) – the main data storage device in a computer.
 [image: ]
 	Other common names for a hard disk drive: hard disk, hard drive, fixed disk, etc.
 	A hard disk drive is a spindle of a set of stacked magnetic disks (platters) that records and stores information (like phonograph records).
 	When you install programs or save data on hard disk of your computer, the information is written to the hard disk.
 	Hard drives can be internal or external.
 
 USB drive – a small portable storage device used to store or transfer data for computers. It is often used for storage, data backup, and transfer of computer files.
 [image: ]
 	USB stands for Universal Serial Bus.
 	Other common names for a USB drive: flash drive, USB stick, pen drive, thumb drive, etc.
 
 Printer – an output device linked to a computer. It transfers the information (text, images, etc.) to paper.
 [image: ]
 





Topic B: Start a computer system or program

Click play on the following audio player to listen along as you read this section.
 [image: Thumbnail for the embedded element "Unit 1 Topic B: Start a computer system or program"] A BCcampus element has been excluded from this version of the text. You can view it online here: https://opentextbc.ca/computerstudies/?p=76 
 
 Start and Shut Down a Computer System
 Start a computer system
 	Press the computer’s Power button.   [image: ]
 If the monitor is not turned on, press the Power button on the monitor.
 	When the computer has finished booting, it will show a dialogue box that will ask for a username and password.
 	Enter your username and password, then click “→ ” (the submit button) or press the Enter key on keyboard.
 
 Shut down a computer system (Windows 10)
 Method 1[image: ]
 	Click the Start icon (at the bottom left corner). [image: ]
 	Click the Power icon on the main menu.[image: ]
 	Click Shut down.
 
 Method 2
 [image: ]
 	Right-click the Start icon. [image: ]
 	Click or hover over Shut down or sign out.
 	Click Shut down.
 
 Log off (or sign out) a computer (Windows 10):
 Method 1
 	Press Ctrl-Alt-Del keys at the same time.
 	Click Sign out.
 
 Method 2
 	Click the Start icon.[image: ]
 	Click the User profile icon.  [image: ]
 	Click Sign out.
 
 Method 3
 	Right-click the Start icon.[image: ]
 	Click or hover over Shut down or sign out.
 	Click Sign out. (Or click Restart to reboot the computer.)
 
 Start a Program
 Start a program or application such as Word, PowerPoint, Paint, etc. (Windows 10)
 Method 1
 	Click the Start icon. [image: ]
 	Click the name of the program that you wish to start (e.g. Word, PowerPoint, etc.).
 
 [image: .]
  
 Method 2
 	Type the program name in the Search box.
 	Click the name of the program that you wish to start.
 [image: ]
 
 
 Method 3
 	Double-click a program shortcut icon on the desktop. (If the program icon is on the desktop.)
 
 [image: ]
 Method 4
 	Click an open program on the taskbar (the bottom edge of the screen).
 
 [image: ]
 Close a Program
 Close (exit) a program (close an active open window)
 Method 1
 	Click the Close icon (x) in the upper-right corner of the window.
 
 [image: .]
 Method 2
 	Click the File, and then click Close.
 
 [image: .]
  
  
 [image: ]
 Method 3
 On your keyboard, press Alt + F4 at the same time.
 [image: ]
 (Always save your document before closing.)
 





Topic C: Online communication

Click play on the following audio player to listen along as you read this section.
 [image: Thumbnail for the embedded element "Unit 1 Topic C: Online communication"] A BCcampus element has been excluded from this version of the text. You can view it online here: https://opentextbc.ca/computerstudies/?p=83 
 
 Email and Video Conferencing
 Online communication refers to the sharing of information or communication over a computer network (the Internet).
 Some popular types of online communication:
 	[image: Phone screen listing different email services, like Gmail, Yahoo!, and Hotmail.]Email (electronic mail) – an Internet service that allows users who have an email account (or address) to send and receive messages anywhere in the world. 	An email may contain attachments (files, photos, etc.).
 	Some free email accounts and service providers: Gmail, AOL Mail, Outlook, Zoho Mail, Yahoo Mail, ProtonMail, Yandex Mail, GMX Mail, etc.
 
 
 	Video conferencing – a live video-based meeting between two or more users in different locations conducted by transmitting audio and video data in real time. 	Some popular video conferencing services: Skype, Zoom, Lifesize, BlueJeans, UberConference, Adobe Connect, etc.
 
 
 
 [image: A screenshot of 12 people video chatting over Zoom]
 Social Networking
 	Social networking – the use of websites and other Internet services to communicate with other people (talk, make new friends, share information, ideas and interests). 	 Some popular social media websites: Facebook, WeChat, Skype, YouTube, Twitter, LinkedIn, Snapchat, Tumblr, Pinterest, TikTok, Instagram, etc.[image: ]
 
 
 
 	Blog (weblog) – a personal website or webpage that is like an online diary/journal. Blogs are written and updated by bloggers (they write about their opinions and thoughts).
 
 [image: ] [image: ]
  
 	VoIP (Voice over Internet Protocol) – a telephone connection over the Internet. It allows users to make calls over the Internet. 	Some popular VoIP: Skype for Business, RingCentral, 8×8, Dialpad, Jive, etc.
 
 
 
 	Chat room – an online service that allows people to communicate by typing messages to each other in real time. 	Some popular chatting sites: Zobe, Badoo, Tiny Chat, Imvu, Chat Avenue, Second life, ChatIb, MocoSpace, FaceFlow, Chat Random, Moco Space, etc.
 
 
 
 [image: ]
 





Topic D: Common uses of computers in society

Click play on the following audio player to listen along as you read this section.
 [image: Thumbnail for the embedded element "Unit 1. Topic D: Common uses of computers in society"] A BCcampus element has been excluded from this version of the text. You can view it online here: https://opentextbc.ca/computerstudies/?p=92 
 
 Computers at Home
 There are many things that a computer can do at home, such as:
 Manage home budget
 	[image: ]Personal finance software can help you create budget, track debt, track spending and savings, reduce or eliminate expenses, plan tax, plan for emergencies, determine short and long-term financial goals, or even just get a better handle on your monthly household spending.
 	Some personal finance software: Personal Capital, Quicken, Buxfer, Moneydance, AceMoney Lite, Buddi, GnuCash, etc.
 
 Work from home
 	[image: ]Some work from home jobs: data entry, web developer, freelance writer, travel agent, call centre representative, online teaching job, software engineer, social media manager, translator, accountant, bookkeeper, etc.
 
 
  
 Online banking
 	[image: ]Online banking is a banking transaction system that allows the bank customers to handle account management and conduct a range of financial transactions via the Internet, rather than visiting a branch.
 	Online banking allows users to make bill payments, view account details, open a new account, money transfers, pre-authorized payments, e-transfer, apply for loans, etc.
 
 Entertainment
 	[image: ]Computers are used in a variety of areas for entertainment purposes, such as videos, movies, television, music, photo editing, and art (for example, paintings, pictures, poetry, etc., are just a click away).
 
 Computer games
 	Some intelligence games are specially developed to improve a user’s cognitive abilities and boost thinking power and mental capability.
 
 Computers in Education and Business
 Computers in education
 [image: ]
 The uses of computers in education are plentiful, such as:
 	Distance education
 	Online courses, programs, and degrees
 	Online training resources
 	eLearning
 	Computer aided teaching and learning. This includes research, school work, storage of information, quick data processing, audio-visual aids in teaching, better presentation of information (PowerPoint, Moodle, smart-boards, etc.), entering and viewing grades online, quick communication between students and instructors, etc.
 
 Computers in business
 [image: ]
 Computer can help a business start, run, manage, and grow. Computers can be used in business for:
 	Marketing and advertising
 	Storage, archiving, and order fulfillment
 	Budgeting and forecasting
 	Customer relationship management
 	e-commerce
 	And more
 
 Without a computer, it can be very difficult to start, run, and grow the business.
 Computers in Healthcare and Science/Engineering
 Computers in healthcare
 [image: A hospital room with two beds.]Computers play a crucial role in the healthcare field, such as:
 	Storing medical and patient data
 	Managing appointments with doctors
 	Medical imaging and equipment. This includes X-rays, CT scans, MRI scans (Magnetic Resonance Imaging—it can produce a detailed body image), etc.
 	Patient monitoring
 	Computer-controlled surgeries
 	Diagnostic databases (create a database of a patient records with their treatment and medicine records)
 	Medical research
 	Blood testing (take blood samples and analyze the results with computer)
 
 Computers in science/engineering
 Computers play a critical role in science/engineering because today is a world of computers.
 	[image: ]Research
 	Design (prototype)
 	Modelling
 	Simulate experiments
 	Record, organize, and analysis data
 	Report/communication
 
 





Unit 1: Self-test

Click play on the following audio player to listen along as you read this section.
 [image: Thumbnail for the embedded element "Sect.1 Unit 1 Self-test"] A BCcampus element has been excluded from this version of the text. You can view it online here: https://opentextbc.ca/computerstudies/?p=93 
 
 Find answers to this self-test at the back of the book: Answers for Self-Tests
 True or false
 	A system unit includes the motherboard, CPU, RAM, hard drive, expansion cards, power supply, etc.
 	A hard drive a computer’s central structure that connects the different parts of a computer together.
 	All information that was stored in RAM is erased when the computer is turned on.
 	A keyboard is an output device that allows a user to enter characters into a computer.
 	Blogs are written and updated by bloggers. They write about their opinions and thoughts.
 	Computer can help business to start, run, manage, and grow.
 
 Fill in the blank
 	The [blank] is the main part of a desktop computer.
 	CPU is the abbreviation for [blank].
 	RAM is a type of data storage used in computers that [blank] stores programs and data.
 	Computer [blank] is a display screen used to display information processed by a computer.
 	USB stands for [blank].
 	When you save data or install programs on your computer, the information is written to the [blank] disk.
 	[Blank] is a telephone connection over the Internet. It allows users to make calls over the Internet.
 	Disk drive is a hardware that stores and retrieves information, data, files, programs, etc. that are used by your computer. The drive is often referred to by the [blank].
 
 Multiple choice
 	The [blank] is often referred to as the brain or engine of a computer. 	CPU
 	motherboard
 	RAM
 	system unit
 
 
 	Which of the following is one of the common names used for CPU? 	processor
 	central processor
 	microprocessor
 	all of the above
 
 
 	Which of the following is one of the common names used for USB drive? 	flash drive
 	pen drive
 	USB stick
 	all of the above
 
 
 	A [blank] is a small flat surface on a laptop or other computer that does the same things as a mouse. 	flash drive
 	trackpad
 	USB stick
 	RAM
 
 
 	Popular social media websites: 	Facebook
 	WeChat
 	LinkedIn
 	all of the above
 
 
 	Computers play a crucial role in science/engineering, such as: 	simulating experiments
 	patient monitoring
 	diagnostic databases
 	all of the above
 
 
 
 





Unit 2. Keyboarding

[image: A small turtle crawls across a keyboard.]
 Topic A: Keyboarding skills
 	Touch typing
 	Keyboarding technique
 
 Topic B: The base position
 	The home row
 	Touch typing rules
 	Typing speed
 
 Unit 2 Self-test
 




Topic A: Keyboarding skills

Click play on the following audio player to listen along as you read this section.
 [image: Thumbnail for the embedded element "Unit 2 Topic A: Keyboarding skills"] A BCcampus element has been excluded from this version of the text. You can view it online here: https://opentextbc.ca/computerstudies/?p=39 
 
 Touch Typing
 Keyboarding skills – the ability to input information at a keyboard smoothly while typing.
 Touch typing – a method of typing (with all the available fingers) without looking at the keyboard.
 	Touch typing can increase typing accuracy and speed.
 	Touch typing includes understanding keyboard layout and its functions.
 
 Benefits of touch typing
 	[image: Hands typing at a computer keyboard.]Speed (efficient): type faster
 	Accuracy (focus): make fewer mistakes
 	Productivity: type longer without getting tired
 	Health: less likely have health problems (hands, wrists, neck, etc.)
 
 Typing tips
 	Maintain a healthy posture.
 	Familiarize yourself with the keyboard layout.
 	Start typing with touch typing.
 	Press each key with the proper finger.
 	Each key has to pressed by the same finger all the time.
 	Take a typing speed test to keep track of your progress.
 
 Keyboarding Technique
 [image: A stick figure sits at a desk with a laptop. Their back is straight and their arms are at 90 degrees over the keyboard.]
 Proper posture
 	Body: centre body in front of keyboard and sit up straight.
 	Arm position: arms relaxed and bent to about 90 degrees; elbows naturally close to body.
 
 The mouse and keyboard should be set to the height of elbow height.
 	Hand position: hands should be flat, but palms of hands not resting on the keyboard. Keep wrists off the keyboard.
 	Feet position: feet should be flat on the ground, slightly apart (don’t cross).
 	Eyes: keep eyes on [image: ]the screen rather than the keyboard or hands.
 
 [image: A woman sitting at a table, looking at a laptop.]
 





Topic B: The base position

Click play on the following audio player to listen along as you read this section.
 [image: Thumbnail for the embedded element "Unit 2 Topic B: The base position"] A BCcampus element has been excluded from this version of the text. You can view it online here: https://opentextbc.ca/computerstudies/?p=45 
 
 The Home Row
 The home row is the set of keys that are the base position for fingers. These are the keys located on the middle row of the keyboard.
  
 [image: A keyboard with two sets of keys in the middle row highlighted.]The home row keys on the keyboard are A, S, D, and F on the left and J, K, L, and the semicolon (;) on the right.

 [image: Fingers on each hand have a base position associated with a specific key on the keyboard. Long description available.][Image Description]

 	Always try to return your fingers to the base position when you are not typing.
 	Keyboards usually have small bumps on the F and J keys. They help the users locate the base position without having to look.
 	Place the index fingers over the “F” and “J” key.
 
 Finger names
 [image: Fingers on the right hand with labels, left to right: thumb, index finger, middle finger, ring finger, and little finger.]
 Touch Typing Rules
 Colour-coded chart
 	Always position your fingers properly on the keyboard to press the right keys when typing.
 	The colour-coded chart below shows which finger should press each key.
 
 [image: A keyboard with the keys grouped into sections. Long description available.]Labelled keyboard. [Image Description]

 [image: ]
 Correct finger placement
 	Press all Section A keys with the left little finger
 	Press all Section B keys with the left ring finger
 	Press all Section C keys with the left middle finger
 	Press all Section D keys with the left index finger
 	Press all Section E with either thumb
 	Press all Section F keys with the right index finger
 	Press all Section G keys with the right middle finger
 	Press all Section H keys with the right ring finger
 	Press all Section I with the right little finger
 
 Typing Speed
 Ways to improve typing speed
 	Familiarizing yourself with the keyboard layout can improve your typing speed.
 	Develop good typing habits; focus on hitting the right keys.
 	Take your time when you have just started learning; slow down to be accurate.
 	Learn to be accurate first, then improve speed.
 	Not only practice often, but practice correctly.
 	Speed will come naturally through practice, repetition, and time.
 
 Take online typing tests
 	Some online typing speed test tools can determine how many words per minute (wpm) you type and how accurate your typing is.
 	There are many free typing tests available online, such as: 	TestMyTypingSpeed
 	10fastfingers
 	Key Hero
 	The Typing Cat
 
 
 
 Image Descriptions
 Home row image description: the base position keys for the left hand are:
 	Little finger: A key
 	Ring finger: S key
 	Middle finger: D key
 	Index finger: F key
 
 The base position keys for the right hand are:
 	Index finger: J key
 	Middle finger: K key
 	Ring finger: L key
 	Little finger: Semi-colon key
 
 [Return to Home row image]
 Labelled keyboard image description: a standard keyboard with the keys grouped into sections labelled A to I from left to right. Each section corresponds to a finger that would press the keys in that section.
 	Section A keys are pressed by the left little finger. The keys include the back quote, Tab, Caps Locks, Shift, Control, the number 1, letters Q, A, and Z, and Alt.
 	Section B keys are pressed by the left ring finger. The keys include the number 2 and letters W, S, and X.
 	Section C keys are pressed by the left middle finger. The keys include the number 3 and and letters E, D, and C.
 	Section D keys are pressed by the left index finger. The keys include numbers 4 and 5, and letters R, T, F, G, V, and B.
 	Section E key is the space bar. The space bar can be pressed by a thumb on either hand.
 	Section F keys are pressed by the right index finger. These keys include numbers 6 and 7, and the letters Y, U, H, J, N, and M.
 	Section G keys are pressed by the right middle finger. These keys include the number 8 and the letters I and K, and the comma.
 	Section H keys are pressed by the right ring finger. These keys include the number 9 and the letters O and L, and the period.
 	Section I keys are pressed by the right little finger. This includes the rest of the keys on the right side of the keyboard, including the number 0, the hyphen, the equals sign, the delete key, the letter P, the open bracket, the close bracket, the backslash, the semicolon, the apostrophe, the enter key, the forward slash, the shift key, the Alt key, and the Control key. [Return to Labelled keyboard]
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 Find answers to this self-test at the back of the book: Answers for Self-Tests
 True or false
 	Hands should be flat, but palms of hands not resting on the keyboard.
 	Feet should be flat on the ground and cross.
 	Keep eyes on the hands rather than the keyboard.
 	Always try to return your fingers to the base position when you are not typing.
 
 Fill in the blank
 	[Blank] typing is a method of typing without looking at the keyboard.
 	[Blank] body in front of keyboard and sit up straight.
 	Base positions or [blank] row keys: the row of keys located on the middle row of the keyboard.
 	The home row keys for the left hand are A, S, [blank], and F.
 	The home row keys for the right hand are J, [blank], L, and the semicolon (;).
 
 Multiple choice
 	Benefits of touch typing: 	speed
 	productivity
 	accuracy
 	all of the above
 
 
 	Arms relaxed and bent to about [blank] degrees; elbows naturally close to body. 	45°
 	60°
 	30°
 	90°
 
 
 	The home row keys for the left hand are A, S, D, and [blank]. 	L
 	F
 	K
 	L
 
 
 	Keyboards usually have small bumps on the [blank] keys. 	S and D
 	A and F
 	F and J
 	all of the above
 
 
 	Press all [blank] keys with the left ring finger. 	pink
 	brown
 	yellow
 	purple
 
 
 	Press all [blank] keys with the left index finger. 	pink
 	brown
 	light green
 	purple
 
 
 	Press all [blank] keys with the right ring finger. 	grey
 	brown
 	light green
 	purple
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Click play on the following audio player to listen along as you read this section.
 [image: Thumbnail for the embedded element "Unit 3. Topic A: Types of computer drives and pointing actions"] A BCcampus element has been excluded from this version of the text. You can view it online here: https://opentextbc.ca/computerstudies/?p=102 
 
 Types of Computer Drives
 Disk drive (drive) – a computer device that stores and retrieves information, data, files, programs, etc., from a disk. The drive is often referred to by its letter (your drive letter may differ).
 	A hard disk drive (hard disk or fixed disk) is usually designated as the “C: drive”. The hard disk drive is the main data storage hardware device in a computer that can provide quick access to large amounts of data. Find more information about computer hardware.
 
 [image: A big metal disk sitting flat beneath a small, angular piece of metal.]
 	A CD/DVD drive is usually designated as the “D: or G: drive”.
 
 [image: A metal and plastic tray that juts out of a computer.]
 	A network drive is usually designated as the “U: drive”.
 
 [image: The back of a computer with several ports and wires sticking out.]
 	A removable disk (USB) is usually designated as the “H: drive” or “K: drive”. 	A USB flash drive is a small portable external device used for data storage.
 	The most common use for external drives (USB) is for backup purposes or to transfer files from one computer to another.
 [image: A small rectangular USB memory drive.]
 
 
 
 Pointing Actions
 Pointing device – a device used to control the movement of the pointer (cursor) on the screen.
 The major pointing devices in use today are the:
 	mouse (desktop computer)
 
 [image: A red computer mouse.]
 	touchpad (laptop)
 
 [image: A shallowly sunken rectangle on a laptop above two rectangular buttons.]
 	touch screen
 
 [image: Hands holding up a tablet computer.]
 Basic pointing actions (use a mouse or trackpad/touchpad)
 	Point and click – point an object on the screen and then press the left button on the mouse (or tap on the trackpad) to select items/commands, open menus/hyperlinks (links), or close windows.
 	Double-click – quickly click the left mouse button twice (or double tap on the trackpad) on any folder, file, or program to open it.
 	Drag and drop – press and hold the left mouse button to grab an item (or double tap on the trackpad) and place it to a different location.
 
 Example: drag the selected text to the new location.
 	[image: An arrow points to the right-side button on a computer mouse.]Right-click – press the right mouse button (or tap two fingers anywhere on the trackpad) to display a popup menu showing commands for a selected item.
 
 





Topic B: Basic file management

Click play on the following audio player to listen along as you read this section.
 [image: Thumbnail for the embedded element "Unit 3 Topic B: Basic file management"] A BCcampus element has been excluded from this version of the text. You can view it online here: https://opentextbc.ca/computerstudies/?p=113 
 
 Folder and File
 [image: ]Folder (or directory) – a virtual storage space used to store and organize computer files.
 	A folder can also contain additional folders (known as subfolders).
 	A folder has a name and is represented by an icon.
 
  
 File – a storage unit on a computer that stores information, data, etc. (such as a document, an image, etc.).
 	Folders contain files
 	Files have names and are represented by various icons
 
 [image: Screenshot of four Word files. All are from Section 1, Units 1 to 4.]
 Filename – a unique name given to a file to identify it. A filename can contain letters, symbols, numbers, spaces, etc.
 [image: ]
 Right-click to create a new folder (Windows 10)
 	Go to the location where you want to create the folder (Desktop, Documents, or anywhere on your computer).
 	Right-click on a blank space (don’t right-click on an existing item in the folder).
 	Click or hover over New.
 	Click Folder.
 	Type a name for the new folder and press Enter (on the keyboard).
 
 Ribbon
 Ribbon – a group of buttons and icons (tabs) at the top of the window that allows users to access the commands that they need to complete a task.
 [image: Microsoft Word ribbon. Icons offer options like bold, change font size, indent, and justify.]
 Create a new folder from the ribbon menu (Windows 10)
 	Go to the location where you want to create the folder (e.g., Documents).
 	Click Home.
 	Click New folder.
 	Type a name for the new folder and press Enter (on the keyboard).
 
 [image: Go to "Home" in File Explorer, then select "New folder" to make a new folder.]
 Basic File Management Skills
 Basic file management refers to a way to name, save, backup, organize files/folders and keep track of files on a computer.
 Some file management tips
 	Create folders/subfolders to organize files.
 	Save your work frequently in folders/subfolders (organize by category).
 	Save your files on a backup disk regularly (back up your files).
 	Give files and folders short, but meaningful names.
 
 Save a file for the first time or save a file with a different name or location (Microsoft Word)
 	Click the File tab in Microsoft Word.
 
 [image: "File" tab in Microsoft Word is highlighted.]
 	Click the Save As command.
 
 [image: "Save as" is highlighted in the "File" menu.]
 	Choose a location on your computer (e.g., USB drive or hard disk drive) to save your file.
 	Type a name for your document in the File Name box.
 	Click the Save button.
 
 [image: ]
 Save an existing file in its current location (Microsoft Word)
 	Click the File tab.
 	Click the Save command.
 	Or click the Save button icon.
 
 [image: ]
 Operate a Printer
 Printer – a device that is usually connected to a computer in order to transfer the text and graphic information to paper.
 [image: A computer printer outputting a colourful document.]
 [image: Microsoft Word print screen. One copy, print all pages, no page range selected.]Operate a printer
 	Load paper in the paper tray if needed.
 	Press the Power button to turn the printer on.
 	Open the file you want to print.
 	Click the File tab.
 	Click the Print command.
 	Select the print options: Number of Copies, Print All pages, or Pages (e.g., from page 2 to page 5), etc.
 	Click Print or Okay to start the printing process.
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 Creating a Document
 Word processing – the use of a program (software application) running on a computer to create, edit, format, and store documents.
 [image: ]Create a new blank document
 	Start Word.
 	Click the File tab.
 	Click New command.
 	Click Blank document. A new blank
 document appears.
 	Type your document (text you type will be
 inserted into the document).
 
 Open an existing document
 	[image: To open an existing document in Word, click File, then Open, then select the document.]Start Word.
 	Click the File tab.
 	Click the Open command.
 	Choose the location on the computer that stores your file (the drive and folder).
 	Click the name of the file you want to open.
 	Click Open or double click the file name.
 
 Check Spelling and Grammar
 Method 1
 	Open an existing document.
 	Right-click a word that is underlined with a wavy line (that indicates a
 misspelled word).
 	Select the correct spelling from the suggestion list (to change the spelling
 error). For each error, Word will offer one or more suggestions.
 
 [image: When you right-click a misspelled word in MS Word, you get suggestions for what you may have meant.]
 Method 2
 	Open an existing document.
 	Click the Review tab.
 	Click the Editor button (it may also be called Spelling & Grammar). If the program finds spelling errors, the Editor pane will
 appear.[image: ]
 	Click one of the options from the suggestion list to change the spelling error.
 	The program will move to the next misspelled word.
 
 Find Synonyms
 Method 1
 	[image: ]Open an existing document.
 	Right-click a word for which you wish to find a synonym.
 	Click the Synonyms command on the pop-out menu.
 	Find a desired word in the list and click it to replace the original word.
 	If none of the synonyms is desired, click the Thesaurus command to open the full
 thesaurus. (The Thesaurus pane will appear.)
 	Find a desired word in the Thesaurus pane list and right-click it, or point to a desired
 word in the Thesaurus pane gradient and
 click the list arrow.
 	Click Insert [the desired word] on the menu
 that opens.
 
 [image: The Thesaurus pane offers different synonyms for different definitions of a word.]
 Method 2
 	Open an existing document.
 	Select a word for which you wish to use the thesaurus.
 	Click the Review tab.
 	Click the Thesaurus button.[image: ]
 	Find a desired word in the Thesaurus pane and right-click it, or point to a desired word in the Thesaurus pane list and click the list arrow.
 	Click Insert [the desired word] on the menu that opens.
 	Close the Thesaurus pane.
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 Find answers to this self-test at the back of the book: Answers for Self-Tests
 True or false
 	Filename: a unique name given to a file to identify it.
 	A folder cannot contain additional folders.
 	Basic file management refers to a way to name, save, backup, organize files/folders and keep tracking of files on a computer.
 	Point and click: press and hold the left mouse button to grab an object and place it to a different location.
 
 Fill in the blank
 	When you save data or install programs on your computer, the information is written to the [blank] disk.
 	A [blank] is a telephone connection over the Internet. It allows users to make calls over the Internet.
 	A computer device that stores and retrieves information, data, files, programs, etc. from a disk. The drive is often referred to by the [blank].
 	A [blank] is a virtual storage space used to store and organize computer files.
 	A [blank] is a device that is usually connected to a computer in order to transfer the text and graphic information to paper.
 	Word processing is the use of a program running on a computer that allows users to create,  [blank], format, and store documents.
 
 Multiple choice
 	The [blank] is a group of buttons and icons at the top of the window. It allows users to access the commands that they need to complete a task. 	stick
 	tab
 	ribbon
 	RAM
 
 
 	A filename can contain: 	letters
 	symbols
 	numbers
 	all of the above
 
 
 	A folder has a name and is represented by [blank]. 	a stick
 	an icon
 	number
 	a tab
 
 
 	[Blank] is the use of a program running on a computer that allows users to create, edit, format and store documents. 	spreadsheet
 	file management
 	word processing
 	all of the above
 
 
 
 [image: A scantron sheet.]
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 Perform a Search Using a Web Search Engine
 Search engine – a web-based tool that is designed to search the content of web pages and find particular information on the Internet.
 Some popular search engines
 	[image: A world map with the names of popular search engines on it.]Google
 	Bing
 	Baidu
 	Yahoo!
 	Yandex
 	Ask.com
 	DuckDuckGo
 
 Search the Internet using a web search engine
 	[image: The Google homepage has a search box where you type your query.]Open a search engine in a web browser (such as Internet Explorer).
 	Type a few specific keywords or phrases in the search box to describe whatever you wish to search. Search engines look for the keywords in your query.
 	Press Enter. The search engine will display a list of websites (page after page) that include information related to your query.
 	Repeat above steps (type different keywords or phrases) if necessary.
 
 Web Browsers and Bookmarks
 Browsers
 	Browser – a software program that allows users to access and display websites or web pages (documents, images, videos, music, etc.) on the Internet.
 
 Some popular web browsers:
 	[image: ]Google Chrome
 	[image: ]Mozilla Firefox
 	[image: ]Internet Explorer
 	[image: ]Safari
 	[image: ]Opera
 
 	
 
 Bookmarks
 	[image: A list of bookmarks made in a web browser.]Bookmark (or favourite): a collection of links (saved shortcuts) to web pages that is stored in a web browser.
 	Saving bookmarks allows users to quickly navigate back to the websites they visit the most.
 	Bookmark bar: A toolbar that contains all bookmarks and is displayed at the top of a browser window (under the address bar).
 
 [image: Bookmark bar is found beneath the address bar.]
 Google Chrome
 Add bookmarks to Google Chrome
 	Open Chrome by double-clicking.[image: ]
 	Go to the website you would like to
 bookmark.
 	Click on the star icon [image: Star.] to the upper-right corner to add the bookmark.
 
 [image: ]
 	Click Done.
 
 [image: ]
 Find a bookmark in Chrome
 Method 1
 	Open Chrome. [image: ]
 	Click three dots (More options) in the upper-right corner.
 
 [image: Three vertical dots in the Chrome toolbar lead to more options.]
 	Click Bookmarks (in the pop-up menu that appears).[image: A Chrome dropdown menu that includes a link to Bookmarks.]
 	Find and click a bookmark to open it.
 
 Method 2
 	Open Chrome. [image: ]
 	Find and click a bookmark on the bookmarks bar to open it.
 
 Show or hide the bookmarks bar in Chrome
 	Open Chrome.
 	Click three dots icon to the upper-right corner.
 	Click Bookmarks.
 	Click Show Bookmarks Bar to turn the bookmarks bar on and off.
 (A check mark means the bookmarks bar is showing. No check mark means it’s hidden.)
 
 [image: In Chrome, click Bookmarks under More Options. Toggle Show Bookmarks on and off.]
 Internet Explorer
 Add bookmarks to Internet Explorer
 	Open Internet Explorer [image: ] double-click on Internet Explorer to open it.[image: Right-click in Explorer, then select Add to favorites.]
 	Go to the website you would like to bookmark.
 	Right-click on an empty space of the page.
 	Select Add to Favorites from the pop-up menu that appears.
 	Click Add.
 
 [image: Name the bookmark, then click Add in the Add a Favorite pop-up box.]
 You may also click on the star icon [image: Star.] in the upper-right corner to add the bookmark.
 Find a bookmark in Internet Explorer
 	Open Internet Explorer.
 	Click on the star icon [image: Star.] in the upper-right corner.
 	Find and click a bookmark to open it.
 
 Or use the bookmarks bar that shows under the address bar. Click a bookmark to open it.
 [image: The bookmarks bar appears below the address bar in Explorer.]
 Show or hide the bookmark bar in Internet Explorer
 	Open Internet Explorer.[image: Toggle the bookmark bar in Explorer by selecting the Favorites bar option.]
 	Right-click on the top side (empty space) of the Window.
 	Click the Favorites bar on the pop-up menu.
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 Fill in Online Forms
 Steps to fill in an online form
 	Save the online form on your computer.
 	Open the form.
 	Click on an empty text field in the form to start filling in the form. Carefully fill in the necessary information. Double check to be sure that there are no mistakes.
 	Add check marks if any are required.
 	Save the form. When done, you can email, print or fax the filled out form.
 
 PDF (Portable Document Format)
 	[image: Icon of an Adobe PDF file.]A PDF is a file format that looks like a printed document. It displays files in a format that is ready for the web.
 	A PDF file allows for incorporation of electronic text, images, graphs, hyperlinks, etc.
 	A PDF file can be viewed, printed, or forwarded to someone else. To view the PDF files, you need the Acrobat Reader, which is available for free download.
 
 Steps to fill in a fillable PDF form
 	[image: An interactive form with empty check and text boxes.]Save the PDF form on your computer.
 	Open the form in Acrobat Reader.
 	Click on an empty text field in the form to start filling in the PDF form.
 	Save the form. When done, you can email, print or fax the filled out form.
 
 
 Use Library Websites to Request Books/Other Resources
 	Open a search engine in a web browser (such as Google in Chrome).
 	Find the website for a library near you.
 	Search the Library Catalogue (type your specific information into the search box). Library Catalogue is the main search box on Library webpages.
 	Click on the title you wish to request (from the results list). Check the availability status.
 	Click on the Place Hold button in the list of items (to place hold on your book).
 	Enter your Library card number (or Username or
 Barcode for some libraries) and PIN number to Log In.
 When you signed up for your library card, you chose a
 personal identification number (PIN).
 	Click on Place Hold(s).
 
 Search methods
 	Searching by title or author: Type keywords from the title or the author’s name into the search box.
 	Searching by subject: Type keywords from your topic into the search box.
 	Searching by ISBN: Type the ISBN number into the search box.
 
 Use Library Websites to Renew Books/Other Resources
 	Open a search engine in a web browser (such as Google in Chrome).
 	Find the website for a library near you.
 	Click on My Account (or Log In in some libraries).
 	Enter your Library card number (or Username or Barcode for some libraries) and PIN number to Log In.
 	Click on Checkouts.
 	Click each title that you would like to renew.
 	Click on Renew. (Renew option will not be available if another user has requested the book.)
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 Find answers to this self-test at the back of the book: Answers for Self-Tests
 True or false
 	A web browser is a collection of links to web pages that is stored in a web browser.
 	Saving bookmarks allows users to quickly navigate back to the websites they visit the most.
 	You can click on the star icon to the upper-right corner (in Chrome) to add a bookmark.
 	Clicking the “Favorites bar” on the pop-up menu cannot show or hide the bookmark bar in Internet Explorer.
 
 Fill in the blank
 	A [blank] is a software program that allows users to access and display websites or web pages on the Internet.
 	The bookmark [blank] contains all bookmarks that shows on the top of the window.
 	A [blank] is a file format that looks like a printed document.
 
 Multiple choice
 	Some common web browsers include: 	Mozilla Firefox
 	Google Chrome
 	Opera
 	all of the above
 
 
 	An Internet [blank] is a web-based tool that is designed to search the content of web pages and to find particular information on the Internet. 	bar
 	 RAM
 	search engine
 	all of the above
 
 
 
 	 Some popular search engines include:
 		Baidu
 	Google
 	Yandex
 	all of the above
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 Security Issues
 Although Internet led to many benefits, it also poses a greater potential for security threats. Below are a number of common Internet security issues.
 Hacker
 Hacker – refers to a person who can gain unauthorized access to (break into) a computer or a network to commit crimes.
 Some things a skilled hacker can do to your computer:
 	Hijack your usernames and passwords;
 	Gain access to the personal information (credit card numbers, bank account, Social Insurance Number, etc.);
 	Steal, change, exploit, sell, or destroy data;
 	Damage or bring down the system;
 	Hold the system hostage to collect ransom;
 
 Malware
 Malware (short for malicious software) – a software that is designed to damage, disrupt, or infect computers.
 	Malware is a single term that refers to all the different types of threats to your computer safety such as virus, Trojan horse, worm, spyware, etc.
 	Malware can gain unauthorized access to a computer and continuously run in the background without the owner’s knowledge.
 
 Computer virus
 Computer virus – a specific type of malware that is designed to replicate (copy) and spread from one computer to another.
 	A virus can make a copy of itself over and over again.
 	A virus can spread from one computer to another through email attachments, removable storage devices, networks (Internet messaging services, download infected files …), etc.
 	A virus can damage your computer by corrupting system files, sending spam, stealing data and personal information from your computer, destroying data, deleting everything on your hard drive, etc.
 
 Trojan horse
 Trojan horse (or Trojan) – a type of malware that looks harmless but can cause harm to a computer system.
 	A Trojan misleads users of its true intent.
 	A Trojan may claim to get rid of your computer viruses but instead introduce viruses onto your computer.
 	A Trojan can take the form of innocent-looking email attachments, downloads, etc.
 
 Worm
 Worm – it is similar to a virus (a sub-class of a virus). It is designed to quickly self-replicate and spread copies of itself from one computer to another.
 	The key difference between a worm and a virus is that a worm does not require any human action to replicate while a virus does. A virus only spreads when a user opens an affected file whereas a worm spreads without the use of a host file.
 
 Phishing
 Phishing – a scammer uses deceptive emails or websites and tries to obtain valuable personal information (i.e., username, password, account number, etc.).
 	Phishing is a common online scam used by cyber criminals.
 	A scammer may use a deceptive email or website appearing to represent a legitimate firm.
 
 Spyware
 Spyware – a software that secretly monitors (spies) user’s online behaviour and gets sensitive information about a person or organization without the user’s knowledge.
 	A spyware can record a user’s Web browsing habits, email messages, keystrokes on online advertisements, personal information, etc., and forward it to a third party.
 	Advertisers can use spyware to target specific advertisements to your tastes.
 	Criminal organizations can use spyware to collect financial information (banking accounts, credit card information, password, etc.).
 
 Prevent Cyber Threats
 Tips on how to prevent malware from infecting your computer
 	Backup files and store in different locations.
 	Don’t open any suspicious/unknown emails or the websites.
 	The second part (the part after the @) of an email should represent the company that owns the email (domain). Example: registrarsoffice@cnc.bc.ca
 (cnc.bc.ca is the domain for the College of New Caledonia)
 
 
 	Don’t download an unknown or suspicious attachment (document, picture, music, game, video, etc.).
 	Do not call fake tech support numbers (tech support scams).
 	If you get pop-up window from fake companies offering to help you with a malware infection, don’t call the number.
 	Use a secure and strong password (unique, hard to guess, etc.).
 	Install anti-malware/virus software (keep it up to date).
 	Scan with antivirus software on a regular basis.
 
 Some free antivirus software
 	[image: ""]Comodo Antivirus
 	AVAST Free Antivirus
 	AVG Antivirus Free
 	Avira Antivirus
 	Bitdefender Antivirus
 	Sophos Home Free
 	Kaspersky Free
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 Email Address
 An email address consists of three parts:
 	Username of the recipient.
 	@ sign (pronounced “at” sign) – every email address consists of an @ sign.
 	Domain (the email service provider – an organization/company, or a website name).
 
 [image: Example emails include regInfo@SFU.ca and userName@GMail.com. In these examples, the email domains are SFU.ca and GMail.com]Example Emails

 Some popular free email service providers include
 	Gmail (username@gmail.com)
 	Outlook (username@outlook.com)
 	Yahoo! Mail (username@yahoo.com)
 	ProtonMail (username@protonmail.com)
 	Zoho (username@zoho.com)
 	AOL (username@aol.com)
 
 Create an Email Account
 This is how you can create a Gmail account.
 	On your computer, open a browser window and go to Gmail.
 
 [image: ""]
 	Click Create an account (top right of screen).[image: ""]
 	Enter your first name, late name, username, and password (twice). Click Next.[image: ""]
 	Provide the additional information, including your birthday and gender. Click Next.[image: ""]
 
  
 	Scroll down and click I agree.[image: Google with ask you to agree to a set of privacy and terms]
 
 Your account will be created and ready to send and receive emails.
 Send and Receive Email
 How to send an email
 	Log into your personal email account (such as Gmail, Outlook, Yahoo! Mail, etc.) or log into your institutional email (many colleges and universities give students an email address).
 	Click Compose (if using Gmail) or something similar. (For example, in Outlook, click New.)
 
 [image: ]
 	Enter a recipient’s email address in the To field. You can also add recipients in the Cc and Bcc fields.
 	Enter a subject (the topic or heading of your email).
 	Type your message in the main body field.
 	Click Send.
 
 [image: ""]
 Cc and Bcc
 	Cc (carbon or courtesy copy) – Entering a person’s email address in the “Cc” field means that person will receive a copy of the email (for their information).
 	Bcc (blind carbon copy) – Bcc is similar to that of Cc except that the email address is invisible to the people in the “To” or “Cc” fields. Use Bcc if you don’t want the other people to see who else has received a copy of the email.
 
 Send Emails with Attachments
 You can attach different types of files to send through email, including PDFs, images, and more. This is how you attach a file to an email:
 	Log in to your email account.
 	Click Compose (Gmail) or something similar (e.g., New in Outlook).
 	Enter a recipient’s email address in the To field.
 	Enter a subject.
 	Type your message in the main body field.
 	Click Attach or something similar. (Note that the Attach option is often represented as a paperclip icon).
 
 [image: ""]
 	Select the file you want to attach from your computer’s folder.
 	Click the Choose or Select button (or another similar button) to attach the file to your email.
 	Click Send.
 
 [image: ]
 Mail System Folders
 	Inbox folder – the place where incoming emails are received and stored (incoming emails arrive in “Inbox” folder).
 	Sent Items (or Sent) folder – the email you’ve sent will be saved in the “Sent Items” (or “Sent Mail”) folder.
 	Drafts folder – an unfinished email will be automatically saved to your “Drafts” folder.
 	Deleted Items folder: every email that you deleted will be moved to the “Deleted Items” folder. 	It’s a good idea to empty your “Deleted Items” folder from time to time in order to save space.
 	To empty the Deleted Items folder: Right-click the Deleted Items folder and click Empty folder, then Ok.
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 Find answers to this self-test at the back of the book: Answers for Self-Tests
 True or false
 	A malware cannot gain unauthorized access to a computer and continuously run in the background without owner’s knowledge.
 	A virus can make a copy of itself over and over again.
 	A Trojan may claim to get rid your computer of viruses but instead introduces viruses onto your computer.
 	The key difference between a virus and a worm is that a worm needs human action to replicate, whereas, a virus doesn’t.
 	Enter a person’s email address to the ‘Cc’ field means that person will receive a copy of the email.
 
 Fill in the blank
 	A [blank] refers to a person who can gain unauthorized access to a computer or a network to commit crimes.
 	A [blank] can spread from one computer to another through email attachments, removable storage devices, networks, etc.
 	A [blank] is similar to a virus. It is designed to quickly self-replicate and spread copies of themselves from one computer to another.
 	A [blank] can record a user’s Web browsing habits, email messages, keystrokes on online advertisements, personal information, etc., and forward it to a third party.
 	Bcc is similar to that of Cc except that the email addresses are [blank] to the people in the “To” or “Cc” fields.
 	The [blank] folder is the place where incoming emails are received and stored.
 	Every email that you delete will be moved to the “[blank] Items” folder.
 
 Multiple choice
 	[Blank] is a software that is designed to infiltrate, damage, disrupt, or infect computers. 	Malware
 	Firefox
 	Yandex
 	RAM
 
 
 	Malware is a single term that refers to all the different types of threats to your computer safety such as: 	Trojan horse
 	worm
 	virus
 	all of the above
 
 
 	[Blank] is a software that secretly monitors (spies) user’s online behaviour and gets sensitive information about a person or organization without the user’s knowledge. 	Trojan horse
 	spyware
 	virus
 	worm
 
 
 	An unfinished email will be automatically saved to your [blank] folder. 	Sent
 	Junk
 	Drafts
 	Deleted items
 
 
 
 [image: ]
 





SECTION II - INTERMEDIATE COMPUTER STUDIES

Section II covers the following topics:
 	Unit 6. Basic computer terminologies
 	Unit 7. Evolution of computers
 	Unit 8. Operating system
 	Unit 9. Basic word processing skills
 	Unit 10. More on word processing
 	Unit 11. More on electronic communication
 
 




Unit 6. Basic computer terminologies

Topic A: Application programs
 	Word processor and spreadsheet
 	Presentation and database programs
 	Launch and terminate a program
 
 Topic B: Types of computers
 	Super computers and mainframe computers
 	Minicomputers and personal computers
 	Types of personal computers
 
 Topic C: Basic computer terminologies and acronyms
 	Basic Internet terminologies
 	Basic computer terminologies
 	Bits and bytes
 
 Unit 6 Self-test
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 Word Processors and Spreadsheets
 Application program – a computer program that provides users with tools to accomplish a specific task.
 Examples of application programs include those for word processing, spreadsheets, presentations, and database management, as well as Internet browsers, email programs, media players, accounting software, and programs that help with pronunciation, translation, desktop publishing, enterprise.
 Microsoft Office – A group of productivity software applications developed by Microsoft Corporation. Microsoft Office 2016 includes such programs as Microsoft Word, Microsoft Excel, and Microsoft PowerPoint.
 Word processors
 Word processor – a program that allows users to create, save, edit, format, print, and retrieve documents.
 Word processing programs can be used to create all types of text-based documents, such as:
 	Assignments
 	Notes
 	Memos
 	Letters
 	Resumes
 	Articles
 	Reports
 	Newsletters
 	Short stories
 	Books (with tables, diagrams, photos, links, etc.)
 
 Examples of word processing programs include Microsoft Word, Google Docs, Apple Pages, and LibreOffice Writer.
 [image: ]
 Spreadsheets
 Spreadsheet (electronic worksheet) – a program that organizes data into rows and columns, also known as tabular form. This data can then be arranged, sorted, calculated (using formulas and functions), analyzed, or illustrated using graphical representations.
 Among many other things, a spreadsheet program can be used to:
 	Create budgets
 	Calculate grades
 	Balance bank accounts
 	Calculate loan payments
 	Calculate tax
 	Prepare payrolls
 	Analyze business performance numbers and results
 	Produce charts
 	Calculate revenues
 
 Examples of spreadsheet programs include Microsoft Excel, Google Sheets, Apple Numbers, and LibreOffice Calc.
 [image: Screenshoot of spreadsheet software.]
 Presentation and Database Programs
 Presentation programs
 [image: An example slide from a presentation.]
 Presentation program – a program that is designed to present information in the form of a slideshow, using multimedia formats such as pictures, sounds, videos, and text. Such a program is commonly used in education, training, business meetings, etc., to create powerful presentations.
 Presentation programs are commonly used to:
 	Create slideshow presentations
 	Create lectures and tutorials
 	Make photo slideshows
 	Design websites with hyperlinks and interactivity
 	Make photo albums
 	Create animated videos (with voice and animation)
 
 Examples of presentation programs include Microsoft PowerPoint, Google Slides, Apple Keynote, Prezi, CustomShow, SlideDog, and Powtoon.
 Database programs
 Database program (database management system) – A program that is designed for creating, editing, updating, maintaining databases, and managing organized information stored in them.
 Databases are useful for keeping track of customers, users, employees, students, inventory, product purchases, ISBN numbers, etc. Database programs are used in the following fields:
 	Banking
 	Airline/railway reservation
 	Library management
 	Education
 	Human resource management
 	Healthcare
 	Weather
 	E-commerce
 	Government
 	Sports
 	Military
 
 Examples of database programs include Microsoft Access, Oracle Database, Knack, TablePlus, and TeamDesk.
 Launch and Terminate a Program
 Launch an application program
 Method 1
 	[image: Menu when click Windows Start button.]Click the Start icon. [image: Microsoft Windows logo.]
 	Click the name of the program that you wish to start (e.g., Word 2016).
 
 Method 2
 	[image: Search box in the Windows Start menu.]Type the program name in the Search box.
 	Click the name of the program that you want to launch.
 
 Method 3
 	Double-click a program shortcut icon on the desktop, if there is one.
 
 Method 4
 	[image: Windows taskbar.]Click a program shortcut on the taskbar at the bottom edge of the screen.
 
 Close (exit) a program (close an active open window)
 Method 1
 	Click the Close icon (x) in the upper-right corner of the window.
 
 Method 2 (Apple)
 	[image: Apple File menu.]Click File in the upper-left corner.
 	Click Close.
 
 Force close a frozen program
 Method 1
 	Click Alt + F4.
 
 Method 2
 	Click Ctrl + Alt + Delete to open Task Manager.
 	Select the unresponsive program and click End Task.
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 Classification of Computers by Size
 	Supercomputers
 	Mainframe computers
 	Minicomputers
 	Personal computers (PCs) or microcomputers
 
 Supercomputers
 [image: A supercomputer.]
 Supercomputer – a powerful computer that can process large amounts of data and do a great amount of computation very quickly.
 Supercomputers are used for areas related to:
 	Science
 	Engineering
 	Education
 	Defence
 	Aerospace
 
 Supercomputers are useful for applications involving very large databases or that require a great amount of computation.
 Supercomputers are used for complex tasks, such as:
 	Weather forecasting
 	Climate research
 	Scientific simulation
 	Oil and gas exploration
 	Quantum mechanics
 	Cryptanalysis
 
 Mainframe computers
 [image: A mainframe computer.]
 Mainframe computer – a high-performance computer used for large information processing jobs.
 Mainframe computers are primarily used in :
 	Institutions
 	Research
 	Academics
 	Health care
 	Libraries
 	Large businesses
 	Financial institutions
 	Stock brokerage firms
 	Insurance agencies
 
 Mainframe computers are useful for tasks related to:
 	Census taking
 	Industry and consumer statistics
 	Enterprise resource planning
 	Transaction processing
 	e-business and e-commerce
 
 Minicomputers
 [image: A minicomputer.]
 Minicomputer – a mid-range computer that is intermediate in size, power, speed, storage capacity, etc., between a mainframe and a microcomputer.
 Minicomputers are used by small organizations.
 “Minicomputer” is a term that is no longer used much. In recent years, minicomputers are often referred to as small or midsize servers (a server is a central computer that provides information to other computers).
 Personal computers
 [image: A personal computer.]
 Personal computer (PC) – a small computer designed for use by a single user at a time.
 A PC or microcomputer uses a single chip (microprocessor) for its central processing unit (CPU).
 “Microcomputer” is now primarily used to mean a PC, but it can refer to any kind of small computer, such as a desktop computer, laptop computer, tablet, smartphone, or wearable.
 Types of personal computers
 Desktop computer – a personal computer that is designed to stay at one location and fits on or under a desk. It typically has a monitor, keyboard, mouse, and a tower (system unit).
 [image: A desktop computer.]
 Laptop computer (or notebook) – A portable personal computer that is small enough to rest on the user’s lap and can be powered by a battery. It includes a flip down screen and a keyboard with a touchpad.
 [image: A laptop computer.]
 Tablet – A wireless touchscreen PC that is slightly smaller and weighs less than the average laptop.
 [image: A tablet computer.]
 Smartphone – A mobile phone that performs many of the functions of a personal computer.
 [image: A smartphone.]
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 Basic Internet Terms and Acronyms
 Internet – A globally connected massive computer network system.
 World Wide Web (WWW or the web) – A system of Internet servers that is made from millions of interlinked websites and web pages.
 Firewall – A network security device designed to prevent unauthorized access to or from a network.
 [image: A router.]
 Router – A device that transfers data between computer networks to provide access to the Internet.
 ISP (Internet Service Provider) – A company that provides Internet service to customers.
 HTTP (Hypertext Transfer Protocol) – A set of rules (a protocol) for transferring and accessing data using the web.
 URL (Uniform Resource Locator) – A web address of a specific web page or file on the Internet. An example is https://www.princegeorgecitizen.com.
 IP (Internet Protocol) – A set of rules (a protocol) for sending data from one computer to another on the Internet. Each computer has a unique IP address that distinguishes it from all other computers on the Internet.
 FTP (File Transfer Protocol) – A set of rules (a protocol) for transferring files between computers over the Internet.
 Cookie – A small text file stored in a user’s computer by a website that the user has visited so that it can remember something about the user at a later time. For example, cookies are used for online shopping. Without cookies, login information would have to be entered before every product was added to the shopping cart.
 Link (hyperlink) – A word, phrase, image, etc., within a file or web page that a user can click on to jump to another document, section of the same document, or web page.
 Basic Computer Terms and Acronyms
 PC (Personal Computer) – a small computer designed for use by a single user at a time.
 Mac (Macintosh) – a type of personal computer made by Apple Inc. It runs a version of the macOS (Apple’s operating system, pronounced “mack-oh-ess”).
 [image: A Macintosh laptop computer.]
 OS (Operating System) – a powerful program that controls and coordinates a computer’s hardware devices and runs software and applications. Examples includes Windows, Android, OS X, and Linux.
 Reboot – to shut down and restart a computer, allowing its operating system and programs to be reloaded.
 CPU (Central Processing Unit) – the brain or engine of a computer, where most of the processing and operations take place.
 [image: A central processing unit (CPU).]
 RAM (Random-Access Memory) – a type of data storage (memory element) used in computers that temporarily stores programs and data. RAM is a kind of volatile memory, meaning its contents are lost when the computer is turned off.
 [image: A RAM stick.]
 ROM (read-only memory) – A type of data storage used in computers that permanently stores data and programs. ROM is a kind of non-volatile memory, meaning its contents are retained even when the computer is turned off.
 [image: A ROM storage device.]
 Bits and Bytes
 [image: Rows of binary.]
 Bit (Binary Digit) – the smallest, most basic unit of measurement for computer data storage, represented as either a 0 or a 1. One byte is equal to 8 bits.
 Byte (Binary Term) – a unit of measurement for data storage. One byte is equal to 8 bits.
 Data Storage Units and Their Properties 	Data Storage Unit 	Symbol 	Power of 10 	One Unit Equals 
 	Byte 	B 	101 	8 bits 
 	Kilobyte 	kB 	103 	1024 B 
 	Megabyte 	MB 	106 	1024 kB 
 	Gigabyte 	GB 	109 	1024 MB 
 	Terabyte 	TB 	1012 	1024 GB 
 	Petabyte 	PB 	1015 	1024 TB 
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 Find answers to this self-test at the back of the book: Answers for Self-Tests
 True or false
 	An application program is a computer program that provides the user with tools to accomplish a specific task.
 	A database is a program that organizes data into rows and columns. This data can then be used to arrange, sort, calculate, analyze, or show graphical representations of data.
 	Common uses for spreadsheet programs include creating slideshow presentations, creating lectures and tutorials, making photo slideshows, and making interesting animations.
 	To launch an application program, click the Start icon, then click the name of the program that you wish to start.
 	Microcomputers are used for complex tasks, such as weather forecasting, climate research, scientific simulation, oil and gas exploration, quantum mechanics, and cryptanalysis.
 	A firewall is a network security device designed to prevent unauthorized access to or from a network.
 	HTTP is a word, phrase, image, etc. within a file on the computer that a user can click on to jump to another document or section of that document.
 
 Fill in the blank
 	[Blank] is a program that allows users to create, save, edit, format, print, and retrieve documents.
 	Common uses for a [blank] program include creating budgets, calculating grades, balancing bank accounts, calculating loan payments, calculating tax, preparing payrolls, and financial analysis.
 	A [blank] program is a program that is designed to present information in the form of a slideshow.
 	[Blank] computers are primarily used by institutions, researchers, academics, healthcare administrators, libraries, large companies and businesses, banking institutions, stock brokerage firms, and insurance agencies.
 	The Internet is a globally connected massive computer [blank] system.
 	The World Wide Web is a system of Internet servers that is made from millions of interlinked websites and [blank].
 	A [blank] is a small text file in the user’s computer stored by a website that the user has visited so that it can remember something about the user at a later time.
 	A [blank] is a powerful program that controls and coordinates a computer’s hardware devices and runs other software and applications on a computer.
 
 Multiple choice
 	A(n) [blank] is an example of application program. 	accounting
 	translation
 	Internet browser
 	all of the above
 
 
 	Microsoft Office 2016 includes 	Microsoft Excel
 	Microsoft Word
 	Microsoft PowerPoint
 	all of the above
 
 
 	To close a program: 	click “View”
 	click “Tools”
 	click the close icon (x)
 	all of the above
 
 
 	To force close a frozen program, click [blank] at the same time. 	Alt + F2
 	Alt + F4
 	Alt + F3
 	Alt + F1
 
 
 	A [blank] computer is a high-performance computer used for large information processing jobs. 	mainframe
 	personal computer
 	laptop
 	desktop
 
 
 
 	A [blank] is a device that transfers data between computer networks to provide access to the Internet. 	FTP
 	URL
 	router
 	ISP
 
 
 	A [blank] is often referred to as the brain or engine of a computer, where most of the processing and operations take place. 	mainframe
 	CPU
 	RAM
 	byte
 
 
 	A byte is a unit of measurement for data storage. 1 GB is equal to 1024 [blank]. 	kB
 	TB
 	PB
 	MB
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 	Basic terms
 	First generation of computers
 	Second generation of computers
 	Third generation of computers
 	Fourth generation of computers
 	Fifth generation of computers
 
 Topic B: Computer hardware and software
 	Computer hardware basics
 	Computer software basics
 	System software
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 Basic Terms
 [image: ]
 Vacuum tube – an electronic device that controls the flow of electrons in a vacuum. It used as a switch, amplifier, or display screen in many older model radios, televisions, computers, etc.
  
 [image: ]
 Transistor – an electronic component that can be used as an amplifier or as a switch. It is used to control the flow of electricity in radios, televisions, computers, etc.
  
 [image: ]
 Integrated circuit (IC) – a small electronic circuit printed on a chip (usually made of silicon) that contains many its own circuit elements (e.g. transistors, diodes, resistors, etc.).
  
 [image: ]
 Microprocessor – an electronic component held on an integrated circuit that contains a computer’s central processing unit (CPU) and other associated circuits.
  
 [image: ]
 CPU (central processing unit) – It is often referred to as the brain or engine of a computer where most of the processing and operations take place (CPU is part of a microprocessor).
  
 [image: ]
 Magnetic drum – a cylinder coated with magnetic material, on which data and programs can be stored.
  
 Magnetic core – uses arrays of small rings of magnetized material called cores to store information.
  
 [image: ]
 Machine language – a low-level programming language comprised of a collection of binary digits (ones and zeros) that the computer can read and understand.
  
 Assembly language is like the machine language that a computer can understand, except that assembly language uses abbreviated words (e.g. ADD, SUB, DIV…) in place of numbers (0s and 1s).
  
 [image: ]Memory – a physical device that is used to store data, information and program in a computer.
  
 Artificial intelligence (AI) – an area of computer science that deals with the simulation and creation of intelligent machines or intelligent behave in computers (they think, learn, work, and react like humans).
 First Generation of Computers
 Classification of generations of computers
 The evolution of computer technology is often divided into five generations.
 Five Generations of Computers 	Generations of computers 	Generations timeline 	Evolving hardware 
  	First generation 	1940s-1950s 	Vacuum tube based 
 	Second generation 	1950s-1960s 	Transistor based 
 	Third generation 	1960s-1970s 	Integrated circuit based 
 	Fourth generation 	1970s-present 	Microprocessor based 
 	Fifth generation 	The present and the future 	Artificial intelligence based 
  
 The main characteristics of first generation of computers (1940s-1950s)
 	Main electronic component – vacuum tube[image: ]
 	Main memory – magnetic drums and magnetic tapes
 	Programming language – machine language
 	Power – consume a lot of electricity and generate a lot of heat.[image: ]
 	Speed and size – very slow and very large in size (often taking up entire room).
 	Input/output devices – punched cards and paper tape.
 	Examples – ENIAC, UNIVAC1, IBM 650, IBM 701, etc.
 	Quantity – there were about 100 different vacuum tube computers produced between 1942 and1963.
 
 Second Generation of Computers
 The main characteristics of second generation of computers (1950s-1960s)
 	[image: ]
 Main electronic component – transistor

 	Memory – magnetic core and magnetic tape / disk
 	[image: ]Programming language – assembly language
 	Power and size – low power consumption, generated less heat, and smaller in size (in comparison with the first generation computers).
 	Speed – improvement of speed and reliability (in comparison with the first generation computers).
 	Input/output devices – punched cards and magnetic tape.
 	Examples – IBM 1401, IBM 7090 and 7094, UNIVAC 1107, etc.
 
 Third Generation of Computers
 The main characteristics of third generation of computers (1960s-1970s)
 	[image: ]Main electronic component – integrated circuits (ICs)
 	Memory – large magnetic core, magnetic tape / disk
 	Programming language – high level language (FORTRAN, BASIC, Pascal, COBOL, C, etc.)[image: ]
 	Size – smaller, cheaper, and more efficient than second generation computers (they were called minicomputers).
 	Speed – improvement of speed and reliability (in comparison with the second generation computers).
 	Input / output devices – magnetic tape, keyboard, monitor, printer, etc.[image: ]
 	Examples – IBM 360, IBM 370, PDP-11, UNIVAC 1108, etc.
 
 Fourth Generation of Computers
 The main characteristics of fourth generation of computers (1970s-present)
 	[image: ]Main electronic component – very large-scale integration (VLSI) and microprocessor.
 	VLSI– thousands of transistors on a single microchip.
 	Memory – semiconductor memory (such as RAM, ROM, etc.) 	RAM (random-access memory) – a type of data storage (memory element) used in computers that temporary stores of programs and data (volatile: its contents are lost when the computer is turned off).
 	[image: ]ROM (read-only memory) – a type of data storage used in computers that permanently stores data and programs (non-volatile: its contents are retained even when the computer is turned off).
 
 
 	Programming language – high level language (Python, C#, Java, JavaScript, Rust, Kotlin, etc.). 	A mix of both third- and fourth-generation languages
 
 
 	Size – smaller, cheaper and more efficient than third generation computers.
 	Speed – improvement of speed, accuracy, and reliability (in comparison with the third generation computers).
 	[image: ]Input / output devices – keyboard, pointing devices, optical scanning, monitor, printer, etc.
 
 	Network – a group of two or more computer systems linked together.
 	Examples – IBM PC, STAR 1000, APPLE II, Apple Macintosh, etc.
 
 [image: ]
 Fifth Generation of Computers
 The main characteristics of fifth generation of computers (the present and the future)
 	[image: ]Main electronic component: based on artificial intelligence, uses the Ultra Large-Scale Integration (ULSI) technology and parallel processing method. 	ULSI – millions of transistors on a single microchip
 	Parallel processing method – use two or more microprocessors to run tasks simultaneously.
 
 
 	Language – understand natural language (human language).
 	Power – consume less power and generate less heat.
 	Speed – remarkable improvement of speed, accuracy and reliability (in comparison with the fourth generation computers).
 	Size – portable and small in size, and have a huge storage capacity.
 	[image: ]Input / output device – keyboard, monitor, mouse, trackpad (or touchpad), touchscreen, pen, speech input (recognise voice / speech), light scanner, printer, etc.
 	Example – desktops, laptops, tablets, smartphones, etc.
 
 [image: Three women sitting around a table with laptops.]
 The computer – this amazing technology went from a government/business-only technology to being everywhere from people’s homes, work places, to people’s pockets in less than 100 years.
 [image: ]
 [image: ]
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 Computer Hardware Basics
 Hardware – any physical device or equipment used in or with a computer system (anything you can see and touch).
 External hardware
 	External hardware devices (peripherals) – any hardware device that is located outside the computer.
 	Input device – a piece of hardware device which is used to enter information to a computer for processing.
 	Examples: keyboard, mouse, trackpad (or touchpad), touchscreen, joystick, microphone, light pen, webcam, speech input, etc.[image: ][image: ]
 	Output device – a piece of hardware device that receives information from a computer.
 	Examples: monitor, printer, scanner, speaker, display screen (tablet, smartphone …), projector, head phone, etc.
 
 [image: ][image: ][image: ]
 Internal hardware
 	Internal hardware devices (or internal hardware components) – any piece of hardware device that is located inside the computer.
 	Examples: CPU, hard disk drive, ROM, RAM, etc.
 
 Computer Software Basics
 Computer software
 	Software – a set of instructions or programs that tells a computer what to do or how to perform a specific task (computer software runs on hardware).
 	Main types of software – systems software and application software.
 
 Application software
 [image: ]
 	Application software – a computer program that provides users with tools to accomplish a specific task.
 	Examples of application software: word processing, spreadsheets, presentation, database management, Internet browsers, email programs, media players, accounting, pronunciation, translation, desktop publishing, enterprise, etc.
 
 System Software
 System software – it is designed to run a computer’s hardware and application software, and make the computer system available for use. It serves as the interface between hardware, application software, and the user.
 [image: A computer functions through interactions between the user, applications, the operating system, and the hardware.]
 	Main functions of system software – allocating system resources, managing storage space, storing and retrieval of files, providing security, etc.
 	Main types of systems software – operating system, device driver, utility software, programming software, etc.
 
 Operating system (OS) – a software that controls and coordinates the computer hardware devices and runs other software and applications on a computer. It is the main part of system software and a computer will not function without it.
 	Main functions of an operating system – booting the computer, managing system resources (CPU, memory, storage devices, printer, etc.), managing files, handling input and output, executing and providing services for application software, etc.
 	Examples of operating system: Microsoft Windows, Apple iOS, Android OS, macOS, Linux, etc.
 
 Device driver – a software program that is designed to control a particular hardware device that is attached to a computer.
 	The main purpose of device driver – it acts as a translator between the hardware device and operating systems or applications that use it.
 	It instructs computer on how to communicate with the device by translating the operating system’s instructions into a language that a device can understand in order to perform the necessary task.
 	Examples of device driver: printer driver, display driver, USB driver, sound card driver, motherboard driver, ROM driver, etc.
 
 Utility software – a type of system software that helps set up, analyze, configure, strengthen, maintain a computer and performs a very specific task (e.g. antivirus software, backup software, memory tester, screen saver, etc.).
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 Find answers to this self-test at the back of the book: Answers for Self-Tests
 True or false
 	A vacuum tube is an electronic device that controls the flow of electrons in a vacuum.
 	A transistor is an electronic component held on an integrated circuit that contains a computer’s CPU and other associated circuits.
 	A magnetic drum uses arrays of small rings of magnetized material called cores to store information.
 	Assembly language is like the machine language that a computer can understand, except that assembly language uses abbreviated words in place of numbers.
 	Internal hardware devices are any hardware device that is located outside the computer.
 	Hardware is a set of instructions or programs that tells a computer what to do or how to perform a specific task.
 	Operating system (OS) is a software that controls and coordinates the computer hardware devices and runs other software and applications on a computer. It is the main part of system software and the computer will not function without it.
 	Utility software is a type of system software that helps set up, analyze, configure, strengthen, maintain a computer and performs a very specific task.
 
 Fill in the blank
 	A [blank] is an electronic component that can be used as an amplifier or as a switch. It is used to control the flow of electricity in radios, TV, computers, etc.
 	The [blank] is often referred to as the brain or engine of a computer where most of the processing and operations take place.
 	[Blank] is a low-level programming language comprised of a collection of binary digits (ones and zeros) that the computer can read and understand.
 	[Blank] is an area of computer science that dealing with the simulation and creation of intelligent machines or intelligent behave in computers.
 	The [blank] language was used in first generation of computers.
 	An [blank] device is a piece of hardware device which is used to enter information to a computer for processing.
 	[Blank] software is designed to run a computer’s hardware and application software, and make the computer system available for use. It serves as the interface between hardware, application software, and the user.
 	A [blank] driver is a software program that is designed to control a particular hardware device that is attached to a computer.
 
 Multiple choice
 	[Blank] is a small electronic circuit printed on a chip usually made of silicon that contains many its own circuit elements 	a microprocessor
 	a vacuum tube
 	a transistor
 	an integrated circuit
 
 
 	[Blank] is a cylinder coated with magnetic material, on which data and programs can be stored. 	a magnetic core
 	a vacuum tube
 	a magnetic drum
 	an integrated circuit
 
 
 	[Blank] is a physical device that is used to store data, information, and program in a computer. 	a magnetic core
 	computer memory
 	a magnetic drum
 	an integrated circuit
 
 
 	The main electronic component used in first generation of computers was: 	transistor
 	CPU
 	integrated circuit
 	vacuum tube
 
 
 	Which language was used in second generation of computer? 	assemble language
 	machine language
 	C++
 	Java
 
 
 	The main electronic component used in fourth generation of computers was: 	transistor
 	CPU
 	VLSI
 	vacuum tube
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Topic A: Basic pointing actions
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 Pointing
 Point and click
 	Pointing device – a device used to control the movement of the pointer (cursor) on the screen.
 	The major pointing devices in use today are the mouse, trackpad or touchpad (laptop), touch screens, etc.
 	Point and click – point an object on the screen and then press a button on the mouse to select objects / commands, open menus / hyperlinks (links), or close windows.
 	Double-click – quickly click the left mouse button twice on any folder, file, or program to open it.
 
 [image: ]
 Left and right click
 	Left-click – press the left mouse button on the left side of the mouse. Left-click is often referred to as “regular-click” and it is used for many common computer tasks, such as selecting objects, closing windows, opening hyperlinks, double-clicking, etc.
 	Right-click – press the right mouse button on the right side of the mouse to display a popup menu showing commands for a selected item.
 
 Scrolling
 Scroll bar
 	Scrolling – sliding content (text, images, etc.) vertically or horizontally on a computer screen and allowing the user to view different parts of information in a window.
 	[image: ]Vertical scroll bar – a vertical bar on the right side of a window or screen that allows the user to scroll the window viewing area up or down.
 	Horizontal scroll bar – a horizontal bar on the bottom of a window or screen that allows the user to scroll the window viewing area to the left or right.
 [image: ]
 
 Scrolling
 	Vertical scrolling – sliding content up or down on a computer screen using a vertical scroll bar.
 	Horizontal scrolling – sliding content left or right on a computer screen using a horizontal scroll bar.
 
 Drag and drop – press and hold the left mouse button to grab an object (such as an icon on the desktop) and place it to a different location.
 Laptop Touchpad
 Laptop touchpad (or trackpad) – an input device for laptop computers that is made up of a flat, touch-sensitive surface. It provides a way to move the cursor around the screen or give an instruction (highlight text, select and open applications, etc.).
 Use a laptop touchpad (or trackpad)
 	[image: ]
 Tap (click) – point an object on the screen and then tap on the trackpad to select items / commands, open menus / hyperlinks (links), or close windows.

 	Double tap (double click) – double tap on the trackpad on any folder, file, program, word, etc. to open / select it.
 	Drag and drop – double-tap the trackpad to grab an object and place it to a different location. Example: drag the selected text to the new location.
 	Right-click – tap two fingers anywhere on the trackpad to display a popup menu showing commands for a selected item.[image: ]
 	Scrolling – tap two fingers on the trackpad and slide fingers up or down to scroll.
 	Select – swipe in from the left or right of the sentence or word (tap the right or left of the sentence or word and swipe towards the other side).
 
 
 





Topic B: Printer
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 Operate a Printer
 How to operate a printer
 [image: ]Printer – a device that is usually connected to a computer in order to transfer the text and graphic information to paper.
 Turn on a printer
 	Plug the printer into a working wall outlet.
 	Make sure the power cord is connected to the rear of the printer.
 	Press the Power button on the printer.
 
 Load paper in the paper tray
 	Pull the paper tray out.[image: ]
 	Load paper in the centre paper tray.
 	Adjust the paper guides to fit the paper size (if necessary).[image: ]
 	Push paper tray completely into the machine.
 
 Get a Printer Online
 If a printer is showing an offline message, it means it can’t communicate with the computer. Bringing a printer online means it can communicate with the computer and it can read and print.
 [image: ]
 Get a printer online
 	Click Start button.[image: ]
 	Type Devices Manager in the search box.[image: ]
 	Click Devices Manager.
 	Click the Action tab (in the top-menu).
 [image: ]      [image: ]
 	Click on the Devices and Printers.[image: ]
 	Right-click on the Offline Printer (it appears faded).
 	Click on See what’s printing.[image: ]
 	Click on the Use Printer Offline.
 
 [image: ]
 Read more on How to Make Printer Online in Windows 10.
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 Files and Folders
 Operating system
 	Recall: operating system (OS) – a software that controls and coordinates the computer hardware devices and runs other software and applications on a computer. It is the main part of system software and the computer will not function without it.
 	Main functions of operating system – booting the computer, managing system resources (CPU, memory, storage devices, printer, etc.), managing files, handling input and output, executing and providing services for application software, etc.
 	Examples of operating system: Microsoft Windows, Apple iOS, Android OS, macOS, Linux, etc.
 
 Files and folders
 	Folder (or directory) – a virtual storage space used to store and organize computer files. 	A folder can also contain additional folders (subfolder – a folder within another folder).
 	A folder has a name and is represented by an icon .
 
 
 	File – a storage unit on a computer that stores information or data (such as a document, an image, etc.). 	Folders contain files.
 	Files have names and are represented by various icons.
 
 
 	Filename – a unique name given to a file to identify it. A filename can contain letters, symbols, numbers, spaces, etc.
 	Files hierarchy – a file system that organizes folders and files in a top-to-bottom structure.
 
 [image: ]
 Create Folders
 Right-click to create a new folder (Windows 10)
 	[image: ]Go to the location where you wish to create the folder (Desktop, Documents or anywhere on your computer).
 	Right-click on a blank space (don’t right-click on an existing item in the folder).
 	Click or hover over New.
 	Click Folder.
 	Type a name for the new folder and press Enter (on a keyboard).
 
 Create a new folder from the ribbon menu (Windows 10)
 Ribbon – a group of buttons and icons (tabs) at the top of the window. It allows users to access the commands that they need to complete a task.
 [image: ]
 	Go to the location where you wish to create the folder (e.g. Documents).
 	Click Home.
 	Click New folder.
 	Type a name for the new folder and press Enter (on a keyboard).[image: ]
 
 Locate Files and Folders
 Locate files and folders – search from the taskbar (Windows 10)
 	[image: ]Type the name of a file or folder (or a keyword from it) into the Search Box (next to the Start Button).
 	Click the matching file or folder name to open it.
 
 Locate files and folders – File Explorer option (Windows 10)
 	Click File Explorer icon (on the taskbar or Start Menu).[image: ]
 	Go to the location where stores your file or folder (hard drive, USB, etc.).
 	Click the name of the file or folder you wish to open.
 	Double click the file or folder name.[image: ]
 
 





Topic D: Copy, move, delete, and rename files/folders
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 Copy Files or Folders
 Copy a file or folder (Windows 10)
 Method 1: Right-click
 	Click File Explorer icon.[image: ]
 	Go to the location where stores your file or folder (hard drive, USB, etc.).
 	Click the name of the file or folder you wish to copy.
 	Right-click the highlighted file or folder and click Copy.[image: ]
 	Go to the destination folder, right-click the destination folder and click Paste.[image: ]
 
 Method 2: Ribbon toolbar commands
 	Click File Explorer icon.[image: ]
 	Go to the location where stores your file or folder (hard drive, USB, etc.).
 	Click the name of the file or folder you wish to copy.
 	[image: ]Click the Home tab at the top (on the ribbon).
 	Click the Copy button.[image: ]
 	Go to the destination location, click the Home tab.
 	Click the Paste button.[image: ]
 
 Move Files or Folders
 Move a file or folder (Windows 10)
 Method 1
 	Click File Explorer icon. [image: ]
 	Go to the location where stores your file or folder (hard drive, USB, etc.).
 	Click the name of the file or folder you wish to move.
 	Click the Home tab at the top (on the ribbon).
 	Click the Move to button.[image: ]
 	Click Choose Location (if you don’t find the right spot on the drop-down menu).
 	Go to the location you want to move for this folder.
 	Click Move.
 
 [image: ]
 Method 2
 	Click File Explorer icon.[image: ]
 	Go to the location where stores your file or folder.
 	Click the name of the file or folder you wish to move.
 	Hold down the right mouse button and drag the file or folder to the location you wish to move.
 
 Difference between copying and moving files / folders
 	Copying – make a duplicate of the selected file or folder and place it in another location.
 	Moving – move the original files or folder from one place to another (change the destination).
 	The move deletes the original file or folder, while copy creates a duplicate.
 
 Delete and Rename Files or Folders
 Delete a file or folder (Windows 10)
 	Click File Explorer icon. [image: ]
 	Go to the location where stores your file or folder.
 	Click the name of the file or folder you wish to delete.
 	[image: ]Press the delete key (on the keyboard) or right click the file or folder and click Delete.
 
 Recover a deleted file or folder
 	Go to Desktop and click the Recycle Bin.
  [image: ]
 	Right-click the name of the file or folder (that you wish to recover). …
 	[image: ]Click Restore. (The file or the folder will be restored to its original location.)
 
 Rename files or folders
 	Click File Explorer icon. [image: ]
 	Go to the location where stores your file or folder.
 	Right click the name of the file or folder you wish to rename.
 	[image: ]Click Rename (on the menu that opens up).
 	Type a new name for the file and press Enter.
 
 Note:
 	If a file is in use, Windows will not allow you to rename the file.
 	Do not change the file extension of a file when renaming the file (file extensions often indicate the file type, file format, etc.).
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 Find answers to this self-test at the back of the book: Answers for Self-Tests
 True or false
 	A pointing device is a device used to control the movement of the keyboard on the screen.
 	Point and click – point an object on the screen and then press a button on the mouse to select objects / commands, open menus / hyperlinks, or close windows.
 	Scrolling – sliding content vertically or horizontally on the keyboard and allowing the user to view different parts of information in a window.
 	Tap (click) – point an object on the screen and then tap on the trackpad to select items / commands, open menus / hyperlinks, or close windows.
 	If a printer is showing an offline message, it means it can communicate with the computer.
 	A folder cannot contain additional folders.
 	The copy deletes the original file or folder, while move creates a duplicate.
 
 Fill in the blank
 	The major pointing devices in use today are the mouse, trackpad or [blank], touch screens, etc.
 	Drag and drop – press and hold the [blank] mouse button to grab an object and place it to a different location.
 	A laptop trackpad is an input device for laptop computer that is made up of a flat, [blank]-sensitive surface. It provides a way to move the cursor around the screen or give an instruction.
 	Drag and [blank] – double-tap the trackpad to grab an object and place it to a different location.
 	A printer is an [blank] device linked to a computer. It transfers the information to paper.
 	Files have names and are represented by various [blank].
 	Files [blank]– a file system that organizes folders and files in a top-to-bottom structure.
 
 Multiple choice
 	[Blank]-click – quickly click the left mouse button twice on any folder, file, or program to open it. 	right
 	double
 	left
 	all of the above
 
 
 	Horizontal scrolling – sliding content [blank] on a computer screen using a horizontal scroll bar. 	right
 	up and down
 	left or right
 	all of the above
 
 
 	Double tap – double tap on the [blank] on any folder, file, program, word, etc. to open / select it. 	keyboard
 	trackpad
 	screen
 	all of the above
 
 
 	[Blank] – tap two fingers anywhere on the trackpad to display a popup menu showing commands for a selected item. 	right-click
 	up-click
 	left-click
 	double-click
 
 
 	Main functions of operating system: 	managing system resources
 	handling input and output
 	booting the computer
 	all of the above
 
 
 	Examples of operating system: 	Apple iOS
 	Linux
 	Windows
 	all of the above
 
 
 
 	A filename can contain: 	spaces
 	numbers
 	letters
 	all of the above
 
 
 	A [blank] is a group of buttons and icons at the top of the window. It allows users to access the commands that they need to complete a task. 	tab
 	ribbon
 	menu
 	all of the above
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 Word processing – the use of a program (software application) running on a computer that allows users to create, edit, format, and store documents.
 Create a Document
 [image: ]Steps to create a new word processing document (Word, Office 365):
 	Start Microsoft Word.
 	Click the File tab.
 	Click the New tab.
 	Click Blank document. (A new blank document appears.)
 	Type your text. The text you type will be inserted into the document.
 
 Edit a Document
 Editing a document – making revisions to a document, focusing on correcting errors, improving the accuracy of language, rearranging, making words and sentences clearer and more effective, etc.
 Editing in word processing may include the following tasks:
 	Adding text (terms, phrases, paragraphs, etc.)
 	Deleting a part of a text
 	Copying text
 	Moving text
 	Pasting text
 	Checking for grammar and spelling
 	Formatting text
 
 Select Text
 Before editing text, you’ll need to select it. This is also sometimes called “highlighting text.”
 	Click File Explorer icon. [image: ]
 	Go to the location where stores your file or folder (hard drive, USB, etc.).
 	Open the document you wish to edit.
 	Move the I-beam pointer [image: ]to where you wish to select text. 	To select a word: double-click the word.
 	To select an entire line of text: move the I-beam to the left of the line until it turns into a right-pointing arrow[image: ], then click.
 	To select a paragraph: triple-click the paragraph.
 	To select any amount of text: click and drag the I-beam over the text to highlight it.
 	To select an entire document: move the I-beam to the left of any text until it turns into a right-pointing arrow [image: ], then triple-click. Or click the Home tab, under Editing, click Select, and then click Select All.
 
 
 
 Delete (or remove) text
 Method 1
 	Select the text you wish to delete.
 	Press the Delete key (on the keyboard).
 
 Method 2
 [image: ]
 	Move the I-beam pointer to the text you want to delete. Click to set the insertion point there (a blinking vertical line).
 	To delete text to the left of the insertion point, press the Backspace key on the keyboard. (On a Mac keyboard, press the Delete key.)
 [image: ]
 	To delete text to the right of the insertion point, press the Delete key on the keyboard. (On a Mac keyboard, press the fn key plus the Delete key.)
 
 Copy and Paste
 Copy vs. cut
 	Copy – duplicates the selected item (text, symbol, table, image, etc.).
 	Cut – removes the selected item from its original position.
 
 Copy and paste vs. cut and paste
 	Copy and paste – duplicates the selected item. The selected item can be found in both original and the new, pasted location(s).
 	Cut and paste – duplicates the selected item then deletes the original. The selected data can be found only at the new, pasted location (the item has moved from one location to another).
 
 Steps to copy / cut and paste
 Method 1
 	Open the document you wish to edit.
 	Select the item you wish to Copy or Cut.
 	Right-click the highlighted item and click Copy or Cut. You can also use your keyboard: 	Copy: Cntr + c (On a Mac, it is Cmd + c)
 	Cut: Cntr + x (On a Mac, it is Cmd + x)
 
 
 
 [image: ]
 	Position the insertion point where you wish to insert the item.
 	Right-click and click the Paste [image: ] icon. You can also use your keyboard by pressing Cntr + v (On a Mac, it is Cmd + v).
 
 [image: ]
 Method 2
 	Open the document you wish to edit.
 	Select the item you wish to copy or cut.
 	Click the Home tab at the top (on the ribbon). Click the Copy button.[image: ]
 	Position the insertion point where you wish to insert the item.
 	Under the Home tab at the top, click the Paste button.[image: ]
 
 Review a Document
 Check Spelling and Grammar
 Method 1
 	Open the document you wish to edit.
 	Right-click a word that is underlined with a wavy line (that indicates a misspelled word).[image: ]
 	Select the correct spelling from the suggestion list to correct the spelling error. For each error, Word will offer one or more suggestions.
 
 Method 2
 	Open the document you wish to edit.
 	Click the Review tab.
 	Click the Editor button (it may also say, “Spelling and Grammar”). If the program finds spelling errors, the Spelling & Grammar pane will appear.[image: ]
 	Click one of the options from the suggestion list to change the spelling error. The program will move to the next misspelled word.
 
 Find Synonyms
 Method 1
 	Open the document you wish to edit.
 	Right-click a word for which you wish to find a synonym for.
 	Click the Synonyms command from the pop-out menu.
 	Find a desired word in the list and click it to replace the original word.
 	If none of the synonyms are desired, click the Thesaurus command to open the full thesaurus. (The Thesaurus pane will appear.)
 	Find a desired word in the Thesaurus pane list and right-click it and then click Insert.
 	Close the Thesaurus pane.
 [image: ]
 
 Method 2
 	Open the document you wish to edit.
 	Select a word for which you wish to use the thesaurus.
 	Click the Review tab.
 	Click the Thesaurus button.[image: ]
 	Find a desired word in the “Thesaurus” pane and right-click it and then click Insert.
 	Close the Thesaurus pane.
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 Save and Retrieve Documents
 Save a new document or save a file to a specific location (Windows 10)
 	Click the File tab.[image: ]
 	Click the Save As command.[image: ]
 	Choose a location on your computer (the drive and folder) to save your file.
 	Type a name for your document in the File Name box.
 	Click the Save button.
 
 [image: ]
 Save an existing file in its current location
 	Click the File tab.
 	Click the Save command.
 	Or click the Save button icon.
 
 [image: ]
 Retrieve a file from a specific location
 [image: ]
 	Start Word.
 	Click the File tab.
 	Click Open command.
 	Choose the location on the computer that stores your file (the drive and folder).
 	Click the name of the file you wish to open.
 	Click Open or double click the file name.
 
 Print a Document
 Printer – a device that is usually connected to a computer in order to transfer the text and graphic information to paper.
 How to print a document in Microsoft Word:
 	Load paper in the paper tray if needed.
 	Press the Power button to turn the printer on.
 	Choose the location on the computer that stores your file (the drive and folder).
 	Open the file you wish to print.
 	Click the File tab.[image: ]
 	Click the Print command.[image: ]
 	Select the print options. Here, you can select: 	How many copies you would like
 	Which pages you want to be printed. You can choose to print all pages, select pages (for example, page 3 to 6), or just the current page (meaning the page that is open on the screen).
 	If the printer should print on one side of the page or both sides.[image: ]
 
 
 	Click Print to start the printing process.
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 Formatting – the appearance of a document. It is the shape, size, form, style, typeface, general arrangement, etc. of a document.
 Page layout – the arrangement of text, graphics, pictures, and other elements on a page. It describes how each page of a document will appear when it is printed.
 Basic page layout properties include
 	Document margins
 	Word / character spacing
 	Line spacing
 	Size and position of figures / images
 	The number of columns
 	How headers and footers appear
 
 [image: A sample layout from two pages of a magazine that uses a combination of headings, block quotes, pictures, and different numbers of columns.]
 Document Margins
 Set document margins (Word 2016)
 	Open the document you wish to set margins.
 	Click the Layout tab in the Ribbon.[image: ]
 	Click the Margins button (in the Page Setup group).[image: ]
 	Choose predefined margin settings (Normal) from the drop-down menu. (Or choose the Custom Margins command and set the margins that you want.)[image: ]
 
 Change the page margins for part of a document
 	Select the part of the document for which you wish to change margins.
 	Click the Layout tab in the Ribbon.
 	Click the Margins button (in the Page Setup group).
 	Click the Custom Margins command and set the margins that you want.
 
 Text Justification and Alignment
 Text justification / alignment – refers to how the left and right edges of a paragraph align on a page.
 Types of justification / alignment
 [image: ]
 	Left-justification (flush left): align text along the left side (ragged on the right).
 	Right-justification (flush right): align text along the right side (ragged on the left).
 	Center-justification: text is aligned to neither the left side nor right.
 	Justify (full justification): align text along the both left and right sides.
 
 [image: ]
 Align the text left
 	Select the text that you wish to align.
 	Click the Align Left icon on the Home tab (or press Ctrl + L or Cmd + L on a Mac).
 	Left align (the standard layout – we read from left to right) is the default alignment for text in a Word document.
 
 Align the text right
 	Select the text that you wish to align.
 	Click the Align Right icon (or press Ctrl + R or Cmd + R on a Mac).
 	Right align is often used when formatting tables of data, attributions to authors of quotes, etc.
 
 Center text
 	Select the text that you wish to align.
 	Click the Center Align icon (or press Ctrl + E or Cmd + E on a Mac).
 	Center-justified text is commonly used on title pages, chapter titles, headings, etc.
 
 Justify text
 	Select the text that you wish to align.
 	Click the Justify icon (or press Ctrl + J or Cmd + J on a Mac).
 	Justification gives text a cleaner, more formal look. Justified text is often used in some newspapers, magazines, books, etc.
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 Bold, Italic, and Underline
 	Bold – a typeface that makes a character thicker than the regular one. Boldfacing is often used for emphasis, headings, subheads, highlight keywords, etc.
 	Italics – a type style with characters that slope to the right. Italic is often used to emphasize a particular word, sentence, or particular part of a document.
 	Underline – add a line underneath the text, in order to show its importance and draw attention to the text.
 
 Make text bold
 	Open the document you wish to format.
 	Select the text for which you wish to bold.
 	Click Bold icon on the Home tab (or press Ctrl/Cmd + B).
 [image: ]
 
 Make text italic
 	Open the document you wish to format.
 	Select the text for which you wish to make italics.
 	Click the Italic icon on the Home tab (or press Ctrl/Cmd + I). [image: ]
 
 Underline text
 	Open the document you wish to format.
 	Select the text for which you wish to underline.
 	Click the Underline icon on the Home tab (or press Ctrl/Cmd + U).[image: ]
 
 [image: ]
 Line Spacing
 Line spacing – the space between lines of text in a paragraph.
 	Most users use either single-spaced lines (one-line height) or double-spaced lines.
 	Line spacing can make a document look cleaner and easy to read.
 
 Set line spacing
 Method 1[image: ]
 	Open the document you wish to edit.
 	Select the text you wish to change the line spacing.
 	Click the Line Spacing icon [image: ] on the Home tab in the Paragraph group.
 	Choose a line-spacing value from the drop-down list.
 
 Method 2
 	Select the text you wish to change the line spacing.
 	Click the Paragraph dialog box launcher button (in the lower right corner of the “Paragraph” group). Or right-click anywhere in the document and then click Paragraph.[image: ]
 	Click the Indents and Spacing tab. 
 	Choose a desired Line Spacing option.
 	Click OK.[image: ]
 
 Method 3
 Use keyboard shortcuts to set line spacing:
 	Single-spacing: Ctrl/Cmd + 1
 	Double-spacing: Ctrl/Cmd + 2
 	1.5-spacing: Ctrl/Cmd + 5
 	1.15-spacing: Ctrl/Cmd + 0
 
 Use Help Features
 Help menu / button – the user can click help button in Word to initiate a search, display the help resources, and aid the user in their task.
 Access help
 	Method 1: Click the Help button on the title bar.[image: ]
 	Method 2: Press the shortcut key F1 to open the Help window.[image: ]
 	Method 3: Use help tutorials. Click out this blog post: Word 2016 – Tell Me Tool
 	Method 4: Get help in the form of a Screen Tip.
 
 Screen Tip (Tool Tip) – a small text box (a hint) appears when the mouse point rest on a command, icon, button, etc. It displays the name of the item and sometimes a brief description of its function and the shortcut key for the command.
 [image: ]
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 Find answers to this self-test at the back of the book: Answers for Self-Tests
 True or false
 	Formatting a document – making revisions to a document, focusing on correcting errors, improving the accuracy of language, rearranging, making words and sentences clearer, more effective, etc.
 	To select a paragraph: double-click the paragraph.
 	To delete text to the left of the insertion point: press the backspace key on the keyboard.
 	Text Justification / alignment refers to how the left and right edges of a paragraph align on a page.
 	Left-justification: align text along the left side (ragged on the left).
 	Bold – a typeface that makes an image thicker than the regular one.
 	Line spacing – the space between lines of text in a paragraph / document. Line spacing can make a document looks cleaner and easy to read.
 
 Fill in the blank
 	[Blank] refers the use of a program running on a computer that allows users to create, edit, format, and store documents.
 	To select any amount of text: click and drag the [blank] over the text to highlight it.
 	Cut removes the selected data from its [blank] position.
 	A [blank] is a device that is usually connected to a computer in order to transfer the text and graphic information to paper.
 	Formatting refers to the [blank] of a document. It is the shape, size, form, style, typeface, general arrangement, etc. of a document.
 	[Blank]-justification: text is aligned to neither the left side nor right.
 	Italics – a type style with characters that slope to the [blank]. Italic is often used to emphasize a particular word, sentence, or particular part of a document.
 	Underline – add a line [blank] the text, in order to show its importance and draw attention to the text.
 	The user can click [blank] menu / button in Word to initiate a search, display the help resources, and aid the user in his / her task.
 
 Multiple choice
 	[Blank]-click refers to quickly click the left mouse button twice on any folder, file, or program to open it. 	right
 	double
 	left
 	all of the above
 
 
 	To select a [blank]: double-click the word. 	document
 	word
 	paragraph
 	all of the above
 
 
 	[Blank] refers to the arrangement of text, graphics, pictures, and other elements on a page. It describes how each page of a document will appear when it is printed. 	formatting
 	editing
 	page layout
 	all of the above
 
 
 	Basic page layout properties: 	the number of columns
 	how headers and footers appear
 	document margins
 	all of the above
 
 
 	Justify (full justification): align text along the [blank]. 	both left and right sides
 	centre
 	right side
 	all of the above
 
 
 	[Blank] is a small text box appearing when the mouse point rest on a command, icon, button, etc. It displays the name of the item and sometimes a brief description of its function and the shortcut key for the command. 	formatting
 	page layout
 	ScreenTip
 	all of the above
 
 
 
 





Unit 10. More on word processing

Topic A: Headers, footers, page numbers, and bullets
 	Create headers in a document
 	Create footers in a document
 	Insert page numbers
 	Create a bulleted or numbered list
 
 Topic B: Tab stops
 	Types of tab stops
 	Set tab stops
 	Remove tab stops
 
 Topic C: Tables, columns, and breaks
 	Insert a table
 	Create and remove columns
 	Insert page breaks
 	Insert section breaks
 
 Unit 10 Self-test
 




Topic A: Headers, footers, page numbers, and bullets

 Click play on the following audio player to listen along as you read this section.
 [image: Thumbnail for the embedded element "Unit 10 Topic A: Headers, footers, page numbers, and bullets"] A BCcampus element has been excluded from this version of the text. You can view it online here: https://opentextbc.ca/computerstudies/?p=326 
 
 Create a Header
 Header – a section of information that appears at the top margin of each page of a document.
 [image: ]
 Method 1
 	Double-click anywhere on the top of a page. A straight line (or a dashed line) on the head will appear.
 	Enter any desired information on the header (such as a chapter title, a document tile, a business logo, the creation date, etc.).
 	Double-click on the body of page (or press the Esc key) to close the header. The header will be on the top of each page.
 
 Method 2
 	Click the Insert tab.
 	Click the Header command.[image: Microsoft Word Toolbar. Header appears under the Insert toolbar.]
 	In the menu that appears, choose a desired header layout (called content control).
 	Enter any desired information on the header.
 	Double-click on the body of page (or press the Esc key) to close the header. The header will be on the top of each page.
 
 Create a Footer
 Footer – a section of information that appears at the bottom margin of each page of a document.
 [image: ]
 Method 1
 
 	Double-click anywhere at the bottom of the page. A straight line (or dashed line) on the footer will appear.
 	Enter any desired information on the footer (such as the page number, author’s name, copyright, references, etc.).
 	Double-click on the body of page (or press the Esc key) to close the footer. The footer will be at the bottom of each page.
 
 Method 2
 	Click the Insert tab.[image: ]
 	Click the Footer command.
 	In the menu that appears, choose a desired footer layout.
 	Enter any desired information on the footer. The footer will be at the bottom of each page.
 	Double-click on the body of page (or press the Esc key) to close the footer.[image: ]
 
 Page Numbers
 Page numbers – Word supports automatically adding page numbers in a multi-page document.
 Insert page numbers
 	Click the Insert tab.
 	Click the Page Number command.[image: ]
 	[image: ]Select a desired position (such as Top of Page, Bottom of Page, etc.) you wish the page number to appear in.
 	Select a desired style (such as Plain Numbers 1, Plain Numbers 2, etc.).
 [image: ]
 
 Change the starting page number
 	[image: ]Click the Insert tab.
 	Click the Page Number command.
 	Select Format Page Numbers.
 	Click Start at and type the page number you wish to appear on the first page.
 	Click OK.
 
 Start page number on page two (hide the page number on the first page)
 	Click Layout.
 	Click the Page Setup Dialog box launcher.[image: ]
 	Select Layout tab and Check the box next to Different first page.[image: ]
 	The page number will disappear from the first page.
 
 Bulleted or Numbered Lists
 Bullet – a dot, a small circle, diamond, or other symbols that is found before the text (a phrase, sentence or paragraph, etc.) to help organize information, make it easier to read, or differentiate between the different points.
 [image: ]
 Insert a bulleted list (a list whose items are bulleted)
 	Select the text you wish to format as a list.
 	Click the Bullets icon.[image: ]
 	Click to select a bullet symbol (i.e., a dot, a small circle, diamond) that you wish to use for the bullet.
 	Deselect the text.
 
 Insert a numbered list (a list whose items are numbered or lettered)
 	Select the text you wish to format as a list.
 	Click the Numbering icon.[image: ]
 	Click to select a number or letter symbol that you wish to use for the list.
 [image: ]
 	Deselect the text.
 
 When you delete or add items in the list, or change the numbering format of the style, the numbers / letters in a list are updated automatically.
 
 





Topic B: Tab stops

Click play on the following audio player to listen along as you read this section.
 [image: Thumbnail for the embedded element "Unit 10 Topic B: Tab stops"] A BCcampus element has been excluded from this version of the text. You can view it online here: https://opentextbc.ca/computerstudies/?p=336 
 
 Tab stop – a location where the cursor (insertion point) would stop when the Tab key is pressed.
 	Tab stops are used to allow users to align text at a specific location in a document.
 	A Tab stop defines length of Indent used at beginning of a line or paragraph.[image: ]
 	[image: ]Pressing the Tab key (on the keyboard) will move the cursor to the next tab stop (which itself is invisible).
 	The tab stop appears on the horizontal ruler at the top of the Word window.
 
 Types of Tab Stops
 	Left Tab – text is aligned to the left of the tab stop.
 	Center Tab – text is centered in the middle of the tab stop.
 	Right Tab – text is aligned to the right of the tab stop.
 	Decimal Tab – numbers are aligned by their decimal points.
 	Bar Tab – inserts a vertical line (bar) into a line of text.[image: ]
 
 Set Tab Stops
 The tab selector (tab indicator) – a small button located in the left corner of the horizontal ruler that supplies the user with a variety of tab marker (tab stop) options (left, right, center, etc.).
 [image: ]
 Insert a tab stop
 Method 1
 	Select the paragraphs / sentences you wish to set tab.
 	Click the Tab Selector until it displays the type of tab stop you wish to use.
 	[image: ]Click on the lower edge of the horizontal ruler at the exact spot where you wish the tab to set. (If you don’t see the ruler at the top of the Word window, click View, then Ruler to display it.)
 	Click to place the insertion point in front of the text where you wish to insert the tab.
 	Press the Tab key on the keyboard.
 
 Method 2
 	Select the paragraphs / sentences you wish to set tab.[image: ]
 	Click the Paragraph dialog box launcher and select the Tabs.[image: ]
 	In the “Tab stop position” box, enter the measurement (such as 4”) on the horizontal ruler where you wish the tab to appear.
 	Under “Alignment”, select a tab stop type (such as Left, Center, Right, Decimal, etc.).[image: ]
 	Click OK.
 
 Remove Tab Stops
 Method 1
 	Select the paragraphs you wish to remove the tab.
 	Drag the tab stop marker off the horizontal ruler.
 
 Method 2
 	Select the paragraphs / sentences you wish to remove the tab.
 	Click the Paragraph dialog box launcher.[image: ]
 	Click to select the Tabs.
 	Click Clear All.
 	Click Ok.[image: ]         [image: ]
 
 





Topic C: Tables, columns, and breaks

Click play on the following audio player to listen along as you read this section.
 [image: Thumbnail for the embedded element "Unit 10 Topic C: Tables, columns, and breaks"] A BCcampus element has been excluded from this version of the text. You can view it online here: https://opentextbc.ca/computerstudies/?p=349 
 
 Insert a Table
 Table – information arranged in a condensed form of columns and rows. It is a more effective way to present information.
 Insert a table in a document (Word 2016)
 Method 1
 	Click where you wish to insert the table in your document.
 	Click the Insert tab and the Table button.[image: ]
 	Drag through to select the desired number of rows and columns (a table will appear).[image: ]
 
 Method 2
 	Click where you wish to create the table in your document.
 	[image: ]Click the Insert tab.
 	Click the Table button.
 	Click Insert Table.
 	Click the up or down arrows (in the Table drop-down menu) to select the desired number of columns.
 	Click the up or down arrows to select the desired number of rows.
 	Click OK to insert the table.
 
 Create and Remove Columns
 Add columns to a document
 	Select the paragraphs you wish to lay out in columns.
 	Click the Layout tab and click the Columns button.[image: ]
 	Click to select the number of columns you wish to create (such as “Two,” in the drop-down menu).
 	The text will lay out in columns.
 
 [image: ]
 Remove columns
 	[image: ]Click anywhere in the columns.
 	Click the Layout tab.
 	Click the Columns button.
 	Click One to change the document as one column.
 
 Insert Page Breaks
 Page break – a page break marks the end of a page that indicates where the printer will start a new page.
 [image: ]
 Insert a page break
 	Click where you wish a new page to begin.
 	Click the Insert tab.
 	Click the Page Break button. A page break is inserted in the document.[image: ]
 	Click on the Home tab and then Show/Hide symbol (¶) will show hidden page beaks (click the Show/Hide symbol again will remove ¶).[image: ]
 
 Insert Section Breaks
 Section break – a section break splits a page into sections that can have a different format or layout within the same page in the document.
 [image: ]
 [image: ]Insert a section break
 	Click where you wish a new section to begin.
 	Click the Layout tab.
 	Click the Breaks button.
 	Click to select the type of section break you wish to use.
 	Click on the Home tab and then Show/Hide symbol (¶) will show hidden section beaks.
 
 Remove a page or section break
 	Click the Home tab.
 	Click the Show/Hide symbol ¶ (to display the section break).
 	Double-click the page or section break to select it.
 	Press the Delete key (on the keyboard).
 
 [image: ]
 





Unit 10: Self-test

Click play on the following audio player to listen along as you read this section.
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 Find answers to this self-test at the back of the book: Answers for Self-Tests
 True or false
 	The footer is a section of information that appears at the bottom margin of each page of a document.
 	Word does not support automatic numbering of pages in a multi-page document.
 	Right Tab – text is aligned to the right of the tab stop.
 	Decimal Tab – numbers are aligned by their vertical bar.
 	Click on the Insert tab and then Show/Hide symbol (¶) will show hidden page beaks.
 
 Fill in the blank
 	A [blank] is a section of information that appears at the top margin of each page of a document.
 	The [blank] is a dot, an asterisk, a small circle, or other symbols that is found before the text to help organize information, make it easier to read, or differentiate between the different points.
 	Bar Tab – inserts a [blank] line into a line of text.
 	A [blank] break splits a page into sections that can have a different format or layout within the same page in the document.
 
 Multiple choice
 	[Blank]-click refers to quickly click the left mouse button twice on any folder, file, or program to open it. 	right
 	double
 	left
 	all of the above
 
 
 	Tab stop – a location where the cursor would stop when the [blank] key is pressed. 	shift
 	return
 	tab
 	all of the above
 
 
 	Center Tab – text is centered in the [blank] of the tab stop. 	left
 	right
 	bar
 	middle
 
 
 	A [blank] break marks the end of a page that indicates where the printer will start a new page. 	section
 	page
 	text
 	all of the above
 
 
 	Right Tab – text is aligned to the [blank] of the tab stop. 	left
 	middle
 	bar
 	right
 
 
 	Decimal Tab – numbers are aligned by their [blank]. 	decimal points
 	tab stop
 	bar
 	all of the above
 
 
 
 





Unit 11. More on electronic communication

Topic A: Web browser
 	Web browser / bookmark
 	Safari
 	Show / hide the bookmark bar in Safari
 	Mozilla Firefox
 	Show / hide the bookmark bar in Firefox
 
 Topic B: Email
 	Email address
 	Create an email account
 	Sending and receiving email
 	Email folders
 	Email attachment
 
 Topic C: Web search engine
 	Perform a search using a web search engine
 	Security issues on the internet
 	Prevent cyber threats
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Topic A. Web browser

Click play on the following audio player to listen along as you read this section.
 [image: Thumbnail for the embedded element "Unit 11 Topic A: Web browser"] A BCcampus element has been excluded from this version of the text. You can view it online here: https://opentextbc.ca/computerstudies/?p=370 
 
 Web Browser / Bookmark
 Browser
 	Browser – a software program that allows users to access and display websites or webpages (documents, images, video, music, etc.) on the internet.
 	Some popular web browsers: 	[image: ]Google Chrome
 	[image: ]Mozilla Firefox
 	[image: ]Internet Explorer
 	[image: ]Safari
 	[image: ]Opera
 
 
 
 Bookmark
 	Bookmark (or favorite) – a collection of links (a saved shortcut) to web pages that is stored in a web browser. Saving bookmarks allows users to quickly navigate back to the websites they visit the most.[image: ]
 	Bookmark bar – it contains all bookmarks that shows on the top of the Window (under the address bar).[image: ]
 
 Safari
 Add bookmarks to Safari
 	[image: ]Open Safari. Double-click on Safari to open it.[image: ]
 	Go to the website you would like to bookmark.
 	[image: ]Click the Share button to the upper-right corner.
 	Click Add Bookmark from the pop-up menu that appears.
 	Choose where to store the bookmark from the pop-up menu (Favorite or a folder).
 	Click Add.[image: ]
 
 Find a bookmark in Safari
 	Open Safari.[image: ]
 	Click the Bookmarks on the top of the Window.[image: ]
 	Select Show Favorites from the pop-up menu that appears.[image: ]
 	Find and click a bookmark to open it. Or click on the Sidebar icon to the upper left-corner (in the Safari toolbar) to open a bookmark.[image: ]
 
 Show / Hide the Bookmark Bar in Safari
 Show or hide the bookmark bar in Safari
 	Open Safari.[image: ]
 	Click the View menu on the top of the Window.[image: ]
 	Select Show (or Hide) Favorites Bar from the pop-up menu that appears depending on whether the bar is on or off. Click Show Favorites Bar to turn the bookmarks bar on. Click Hide Favorites Bar to turn the bookmarks bar off.[image: ]
 
 Mozilla Firefox
 Add bookmarks to Firefox
 	Open Firefox. [image: ]
 	[image: ]Double-click on Firefox to open it.
 	Go to the website you would like to bookmark.
 	Click on the star icon to the right of the address bar.
 	Click Done to add the bookmark.
 
 Find a bookmark in Firefox
 	Open Firefox.
 	Type the first word of your bookmark in address bar. As you type in address bar, Firefox will suggest websites (bookmark) you’ve visited.
 	Find and click a bookmark to open it (to see your favorites). [image: ]
 
 Show or hide the bookmark bar in Firefox
 	Open Firefox. [image: ]
 	Click on the three-line icon to the upper-right corner.[image: ]
 	Click Library on the pop-out menu.[image: ]
 	Click Bookmarks on the pop-up Library menu.[image: ]
 	Click the Bookmarking Tools on the pop-up Bookmarks menu.[image: ]
 	Click the View or Hide Bookmarks Toolbar in the Bookmarking Tools menu to turn the bookmarks bar on and off.[image: ]
 
 





Topic B. Email

Click play on the following audio player to listen along as you read this section.
 [image: Thumbnail for the embedded element "Unit 11 Topic B: Email"] A BCcampus element has been excluded from this version of the text. You can view it online here: https://opentextbc.ca/computerstudies/?p=382 
 
 Email Address
 	Email (electronic mail) – an Internet service that allows users who have an e-mail account (address) to send and receive messages anywhere in the world. 	An email may contain attachments (files, photos, videos, etc.).
 	Some free email accounts and service providers: Gmail, AOL Mail, Outlook.com, Zoho Mail, com, Yahoo Mail, ProtonMail, Yandex Mail, GMX Mail, etc.[image: ]
 
 
 	An email address consists of three parts: 	User name of the recipient.
 	@ sign (at sign) – every email address consists of an @ sign.
 	Domain (email service provider – an organization / company, or a website name).[image: ]
 
 
 
 Popular Free Email Providers 	Email provider 	Sample email addresses 
 	Gmail 	username@gmail.com 
 	Outlook 	username@outlook.com 
 	Yahoo! Mail 	username@yahoo.com 
 	ProtonMail 	username@protonmail.com 
 	Zoho 	username@zoho.com 
 	AOL 	username@aol.com 
  
 Create an Email Account
 Create a Gmail account
 	On your computer, go to the Google Account creation page.[image: ]
 	Enter your first, last name, username, and password (twice).
 	Click Next.
 [image: ""]
 	Enter your phone number (optional).
 	Enter “Recovery email address” (optional).
 	Enter your birthday, and gender.
 	Click Next.
 	Scroll down and click I agree. Your account will be created and ready to send and receive emails.
 [image: ]
 
 [image: ]Sending and Receiving Email
 Steps for sending and receiving emails
 	Log into your email account (such as Gmail, Outlook, Yahoo! Mail, etc.). Or log into your institutional email (many colleges / universities give students an email address).
 	Click Compose (Gmail) or something similar (e.g., New in Outlook).
 	Enter a recipient’s email address in the “To” field. (You can also add recipients in the “Cc” and “Bcc”
 fields.)
 	Enter a subject (the topic or heading of your email).
 	Type your message in the main body field.
 	Click Send at the bottom of the page.
 
 [image: ]
 Cc and Bcc
 	Cc (carbon or courtesy copy) – entering a person’s email address in the “Cc” field means that person will receive a copy of the email (for their information).
 	Bcc (blind carbon copy) – Bcc is similar to that of Cc except that the email address is invisible to the people in the “To” or “Cc” fields. Use Bcc if you don’t want the other people to see who else has received a copy of the email.
 
 Email Folders
 	[image: ]Inbox folder – the place where incoming emails are received and stored (incoming emails arrive in the “Inbox” folder).
 	Sent Mail folder – the email you’ve sent will be saved in the “Sent Mail” (or “Sent Items”) folder.
 	Drafts folder – an unfinished email will be automatically saved to your ‘Drafts’ folder.
 	Junk Email folder – the Junk Email Filter feature moves suspected incoming emails (spams) to the Junk Email folder (a place used to store spam emails).
 	Deleted items folder: every email that you deleted will be moved to the “Deleted Items” folder. 	It’s a good idea to empty your “Deleted Items” folder from time to time in order to save space.
 	To empty the Deleted Items folder: Right-click the Deleted Items folder and click Empty, then Ok.[image: ]
 
 
 
 Email Attachment
 Steps to send emails including attachments
 	Log into your email account.
 	Click Compose (Gmail) or something similar (e.g., New in Outlook).
 	Enter a recipient’s email address in the “To” field.
 	Enter a subject.
 	Type your message in the main body field.
 	Click Attach or something similar (e.g., the paper click icon).[image: ]
 [image: ]
 	Select the file you want to attach from your computer’s folder.
 	Click the Open or another similar button to attach the file to your email.
 	Click Send at the bottom of the page.
 
 





Topic C: Web search engine
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 Perform a Search using a Web Search Engine
 Search engine – an Internet search engine is a web-based tool (a software) that is designed to search the content of web pages and to find particular information on the Internet.
 Some popular search engines
 	[image: ]Google
 	Bing
 	Baidu
 	Yahoo!
 	Yandex
 	Ask.com
 	DuckDuckGo
 
 Search the Internet using a web search engine
 	Open a search engine in a web browser (such as Google in Chrome).
 	Type a few specific keywords or phrases to describe whatever you wish to search in the search bar. Search engines look for the keywords in your query.
 	Press the Enter key on the keyboard.
 	Repeat above steps if necessary.[image: ]
 
 Security Issues on the Internet
 Internet security issues
 Although Internet led to many benefits, it also poses a greater potential for security threats.
 The common Internet security issues
 	Hacker – refers to a person who can gain unauthorized access (break into) to a computer or a network to commit crimes.
 	Some things a skilled hacker can do to your computer: 	Hijack your usernames and passwords;
 	Gain access to the personal information (credit card numbers, bank account, social insurance number, etc.);
 	Steal, change, exploit, sell or destroy data;
 	Damage or bring down systems;
 	Hold those system hostages to collect ransom.
 
 
 	Malware (short for malicious software) – a software that is designed to damage, disrupt, or infect computers. 	Malware can gain unauthorized access to a computer and continuously run in the background without owner’s knowledge.
 	Malware is a single term that refers to all the different types of threats to your computer safety such as virus, Trojan horse, worm, spyware, etc.
 
 
 	Computer virus – a specific type of malware that is designed to replicate (copy) and spread from one computer to another. 	A virus can make a copy of itself over and over again.
 	A virus can spread from one computer to another through email, removable storage devices, networks (e.g. internet messaging services, download infected files …), etc.
 	A virus can damage your computer by corrupting system files, sending spam, stealing data and personal information from your computer, destroying data, deleting everything on your hard drive, etc.
 
 
 	Trojan horse(or Trojan) – a type of malware that looks harmless but can damage, disrupt, steal data on your computer. 	A Trojan misleads users of its true intent.
 	A Trojan may claim to get rid of your computer viruses but instead introduces viruses onto your computer.
 	A Trojan can take the form of an innocent-looking email attachment, download, etc.
 
 
 	Worm – it is similar to a virus (a sub-class of a virus). It is designed to quickly self-replicate and spread copies of themselves from one computer to another. 	The key difference between a virus and a worm is that a virus needs human action to replicate, whereas, a worm doesn’t.
 	A virus only spreads when a user opens an affected file whereas a worm spreads without the use of a host file.
 
 
 	Phishing – a scammer uses deceptive emails or websites and tries to obtain valuable personal information (i.e., username, password, account number, etc.). 	Phishing is a common online scam used by cyber criminals.
 	A scammer may use a deceptive email or website appearing to represent a legitimate firm.
 
 
 	[image: ]Spyware – a software that secretly monitors (spies) user’s online behavior and gets sensitive information about a person or organization without the user’s knowledge. 	A spyware can record a user’s Web browsing habits, e-mail messages, keystrokes on online advertisements, personal information, etc., and forward it to a third party.
 	Advertisers can use spyware to target specific advertisements to your tastes.
 	Criminal organizations can use spyware to collect financial information (banking accounts, credit card information, password, etc.).
 
 
 
 Prevent Cyber Threats
 Tips on how to prevent malware from infecting your computer
 	Backup files and store in different locations.
 	Don’t open any suspicious / unknown emails or the websites. The second part (the part after the @ ) of an email / website address should represent the company that owns the email / website (domain).
 [image: ]
 	Don’t download an unknown or a suspicious attachment (document, picture, music, game, video, etc.).
 	Do not call fake tech support numbers (tech support scams). If you get pop-up window from fake companies offering to help you with a malware infection, don’t call the number.
 	Use a secure and strong password (unique, hard to guess, etc.).
 	Install anti-malware / virus software (keep it up to date).
 	Scan with antivirus software on a regular basis.
 
 [image: ]
 Some free antivirus software:
 	Comodo Free Antivirus
 	AVAST Free Antivirus
 	AVG Antivirus Free
 	Avira Antivirus
 	Bitdefender Antivirus Free
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 Find answers to this self-test at the back of the book: Answers for Self-Tests
 True or false
 	A bookmark is a software program that allows users to access and display websites or webpages on the internet.
 	A web browser is a collection of links to web pages that is stored in a bookmark.
 	An email may contain attachments (files, photos, videos, etc.).
 	Bcc is similar to that of Ccexcept that the email address is invisible to the people in   the “To” or “Cc” fields.
 	An unfinished email will be automatically saved to your ‘Income’ folder.
 	Although the Internet led to many benefits, it also poses a greater potential for security threats.
 	Malware is a single term that refers to all the different types of threats to your computer safety such as virus, Trojan horse, worm, spyware, etc.
 
 Fill in the blank
 	Saving [Blank] allows users to quickly navigate back to the websites they visit the most.
 	A bookmark [Blank] contains all bookmarks that shows on the top of the Window.
 	Click on the [Blank] icon to the right of the address bar can add the bookmark to Firefox.
 	Email – an Internet service that allows users who have an [Blank] account to send and receive messages anywhere in the world.
 	Enter a person’s email address to the [Blank] field means that person will receive a copy of the email.
 	The email you’ve [Blank] will be saved in the Sent Mail (or Sent Item) folder.
 	An internet [Blank] is a web-based tool that is designed to search the content of web pages and to find particular information on the Internet.
 	A [Blank] refers to a person who can gain unauthorized access to a computer or a network to commit crimes.
 	[Blank] is a software that is designed to damage, disrupt, or infect computers.
 	A computer [Blank] is a specific type of malware that is designed to replicate and spread from one computer to another.
 	Advertisers can use [Blank] to target specific advertisements to your tastes.
 
 Multiple choice
 	Click the [Blank] Bookmarks Toolbar in the Bookmarking Tools menu to turn the bookmarks bar on and off. 	On / Off
 	Open / Close
 	View / Hide
 	All of the above
 
 
 	An email address consists of: 	@ sign
 	username
 	domain
 	all of the above
 
 
 	Incoming emails arrive in the [Blank] folder. 	Sent Mail
 	Inbox
 	Drafts
 	Junk Email
 
 
 	[Blank] is a type of malware that looks harmless but can damage, disrupt, steal data on your computer. 	phishing
 	spyware
 	a Trojan horse
 	a worm
 
 
 
 




1
Glossary

 	application program (or application software)
 	a computer program that provides users with tools to accomplish a specific task.
 
 	artificial intelligence (AI)
 	an area of computer science that deals with the simulation and creation of intelligent machines or intelligent behave in computers (they think, learn, work, and react like humans).
 
 	basic file management
 	a way to name, save, backup, organize, and keep track of files and folders on a computer.
 
 	Bcc (blind carbon copy)
 	Bcc is similar to that of Cc except that the email address is invisible to the people in the “To” or “Cc” fields. Use Bcc if you don't want the other people to see who else has received a copy of the email.
 
 	bit
 	the smallest, most basic unit of measurement for computer data storage, represented as either a 0 or a 1. One byte is equal to 8 bits.
 
 	blog
 	a personal website or webpage that is like an online diary/journal.
 
 	bold
 	a typeface that makes a character thicker than the regular one. Boldfacing is often used for emphasis, headings, subheads, highlight keywords, etc.
 
 	bookmark (or favourite)
 	a collection of links (a saved shortcut) to web pages that is stored in a web browser. 
 
 	bookmark bar
 	a row of all bookmarks that shows on the top of a browser window (under the address bar).
 
 	browser
 	a software program that allows users to access and display websites or web pages (documents, images, video, music, etc.) on the Internet.
 
 	bullet
 	a dot, a small circle, diamond, or other symbol that is found before the text in a list (a phrase, sentence or paragraph, etc.) to help organize information, make it easier to read, or differentiate between the different points.
 
 	byte
 	a unit of measurement for data storage. One byte is equal to 8 bits.
 
 	Cc (carbon copy or courtesy copy)
 	entering a person's email address in the “Cc” field means that person will receive a copy of the email (for their information).
 
 	center-justification
 	text is aligned to neither the left side nor right.
 
 	chat room
 	an online service that allows people to communicate by typing messages to each other in real time.
 
 	computer monitor
 	a display screen used to display information (text, image, video, etc.) processed by a computer.
 
 	computer system
 	a complete computer that includes a system unit along with all its software (such as Office 2016, Windows 10, etc.) and peripheral devices (such as a mouse, keyboard, monitor, printer, etc.) connected to it.
 
 	computer virus
 	a specific type of malware that is designed to replicate (copy) and spread from one computer to another.
 
 	cookie
 	A small text file stored in a user's computer by a website that the user has visited so that it can remember something about the user at a later time.
 
 	copy
 	make a duplicate of the selected items (text, symbol, table, image, etc.) and place it in another location.
 
 	CPU (central processing unit)
 	The brain or engine of a computer, where most of the processing and operations take place.
 
 	cut
 	removes the selected item from its original position.
 
 	database program
 	a program that is designed for creating, editing, updating, and maintaining databases and managing organized information stored in them.
 
 	deleted items
 	an email folder that saves all emails that have been deleted.
 
 	desktop computer
 	a personal computer that is designed to stay at one location and fits on or under a desk. It typically has a monitor, keyboard, mouse, and a tower (system unit).
 
 	device driver
 	a software program that is designed to control a particular hardware device that is attached to a computer.
 
 	disk drive
 	a computer device that stores and retrieves information, data, files, programs, etc., from a disk.
 
 	double-click
 	quickly click the left mouse button twice on any folder, file, or program to open it.
 
 	drafts
 	an email folder that automatically saves unfinished emails.
 
 	drag and drop
 	press and hold the left mouse button to grab an object (such as an icon on the desktop) and place it to a different location.
 
 	Editing a document
 	making revisions to a document, focusing on correcting errors, improving the accuracy of language, rearranging, making words and sentences clearer, more effective, etc.
 
 	email
 	an Internet service that allows users who have an email account (or address) to send and receive messages anywhere in the world.
 
 	external hardware devices (peripherals)
 	any hardware device that is located outside the computer.
 
 	file
 	a storage unit on a computer that stores information, data, etc. (such as a document, an image, etc.).
 
 	filename
 	a unique name given to a file to identify it.
 
 	files hierarchy
 	a file system that organizes folders and files in a top-to-bottom structure.
 
 	firewall
 	a network security device designed to prevent unauthorized access to or from a network.
 
 	folder (or directory)
 	a virtual storage space used to store and organize computer files.
 
 	footer
 	a section of information that appears at the bottom margin of each page of a document.
 
 	formatting
 	the appearance of a document. It is the shape, size, form, style, typeface, general arrangement etc. of a document.
 
 	FTP (File Transfer Protocol)
 	a set of rules (a protocol) for transferring files between computers over the Internet.
 
 	hacker
 	a person who can gain unauthorized access to (break into) a computer or a network to commit crimes.
 
 	hard disk drive
 	the main data storage device in a computer.
 
 	hardware
 	any physical device or equipment used in or with a computer system (anything you can see and touch).
 
 	header
 	a section of information that appears at the top margin of each page of a document.
 
 	help menu / button
 	the user can click help button in Word to initiate a search, display the help resources, and aid the user in his / her task. 
 
 	horizontal scroll bar
 	a horizontal bar on the bottom of a window or screen that allows the user to scroll the window viewing area to the left or right.
 
 	horizontal scrolling
 	sliding content left or right on a computer screen using a horizontal scroll bar.
 
 	HTTP
 	short for Hypertext Transfer Protocol. A set of rules (a protocol) for transferring and accessing data using the web.
 
 	inbox
 	an email folder where incoming emails are received and stored.
 
 	input device
 	a piece of hardware device which is used to enter information to a computer for processing.
 
 	integrated circuit (IC)
 	a small electronic circuit printed on a chip (usually made of silicon) that contains many its own circuit elements (e.g. transistors, diodes, resistors, etc.).
 
 	internal hardware devices (or internal hardware components)
 	any piece of hardware device that is located inside the computer.
 
 	Internet
 	a globally connected massive computer network system.
 
 	IP (Internet Protocol)
 	a set of rules (a protocol) for sending data from one computer to another on the Internet.
 
 	ISP (Internet service provider)
 	a company that provides Internet service to customers.
 
 	italics
 	a type style with characters that slope to the right. Italic is often used to emphasize a particular word, sentence, or particular part of a document.
 
 	junk email
 	the Junk Email Filter feature moves suspected incoming emails (spams) to the Junk Email folder (a place used to store spam emails).
 
 	justify (full justification)
 	align text along the both left and right sides. 
 
 	keyboard
 	an input device that allows a user to enter characters (letters, numbers, symbols, etc.) and commands into a computer.
 
 	keyboarding skills
 	the ability to input information through a keyboard smoothly while typing.
 
 	laptop computer
 	a portable personal computer that is small enough to rest on the user's lap and can be powered by a battery. It includes a flip down screen and a keyboard with a touchpad. Also known as a notebook.
 
 	left-click
 	press the left mouse button on the left side of the mouse. Left-click is often referred to as “regular-click” and it is used for many common computer tasks, such as selecting objects, closing windows, opening hyperlinks, double-clicking, etc.
 
 	left-justification (flush left)
 	align text along the left side (ragged on the right).
 
 	line spacing
 	the space between lines of text in a paragraph / document.
 
 	link
 	a word, phrase, image, etc., within a file or web page that a user can click on to jump to another document, section of the same document, or web page. Also known as a hyperlink.
 
 	Mac
 	a type of personal computer made by Apple Inc. Short for Macintosh.
 
 	machine language
 	a low-level programming language comprised of a collection of binary digits (ones and zeros) that the computer can read and understand.
 
 	magnetic core
 	uses arrays of small rings of magnetized material called cores to store information.
 
 	magnetic drum
 	a cylinder coated with magnetic material, on which data and programs can be stored.
 
 	mainframe computer
 	a high-performance computer used for large information processing jobs.
 
 	malware
 	a software that is designed to damage, disrupt, or infect computers.
 
 	memory
 	a physical device that is used to store data, information, and programs in a computer.
 
 	microprocessor
 	an electronic component held on an integrated circuit that contains a computer's central processing unit (CPU) and other associated circuits.
 
 	Microsoft Office
 	a group of productivity software applications developed by Microsoft Corporation. Microsoft Office 2016 includes such programs as Microsoft Word, Microsoft Excel, Microsoft PowerPoint, etc.
 
 	minicomputer
 	a mid-range computer that is intermediate in size, power, speed, storage capacity, etc., between a mainframe and a microcomputer.
 
 	motherboard
 	the main circuit board of a computer; also known as the mainboard.
 
 	mouse
 	a hand-held pointing device that can control the position of a cursor on a display screen.
 
 	moving
 	move the original files or folder from one place to another (change the destination).
 
 	online communication
 	the sharing of information or communication over a computer network.
 
 	operating system (OS)
 	a software that controls and coordinates the computer hardware devices and runs other software and applications on a computer. It is the main part of system software and a computer will not function without it.
 
 	output device
 	a piece of hardware device that receives information from a computer.
 
 	page break
 	a page break marks the end of a page that indicates where the printer will start a new page.
 
 	page layout
 	the arrangement of text, graphics, pictures, and other elements on a page. It describes how each page of a document will appear when it is printed.
 
 	page numbers
 	Word supports automatically adding page numbers in a multi-page document.
 
 	personal computer
 	a small computer designed for use by a single user at a time. Also known as a PC or a microcomputer.
 
 	phishing
 	when an Internet scammer uses deceptive emails or websites to try to obtain valuable personal information from people.
 
 	point and click
 	point an object on the screen and then press a button on the mouse to select objects / commands, open menus / hyperlinks (links), or close windows.
 
 	pointing device
 	a device used to control the movement of the pointer (cursor) on the screen.
 
 	presentation program
 	a program that is designed to present information in the form of a slideshow, using multimedia formats such as pictures, sounds, videos, and text.
 
 	printer
 	an output device linked to a computer that transfers the information (text, images, etc.) to paper.
 
 	RAM (random-access memory)
 	a type of data storage (memory element) used in computers that temporarily stores programs and data. RAM is a kind of volatile memory, meaning its contents are lost when the computer is turned off.
 
 	reboot
 	to shut down and restart a computer, allowing its operating system and programs to be reloaded.
 
 	ribbon
 	a group of buttons and icons (tabs) at the top of the window that allows users to access the commands that they need to complete a task.
 
 	right-click
 	press the right mouse button on the right side of the mouse to display a popup menu showing commands for a selected item.
 
 	right-justification (flush right)
 	align text along the right side (ragged on the left).
 
 	ROM (read-only memory)
 	a type of data storage used in computers that permanently stores data and programs. ROM is a kind of non-volatile memory, meaning its contents are retained even when the computer is turned off.
 
 	router
 	a device that transfers data between computer networks to provide access to the Internet.
 
 	ScreenTip (ToolTip)
 	a small text box (a hint) appears when the mouse point rest on a command, icon, button, etc. It displays the name of the item and sometimes a brief description of its function and the shortcut key for the command.
 
 	scrolling
 	sliding content (text, images, etc.) vertically or horizontally on a computer screen and allowing the user to view different parts of information in a window.
 
 	search engine
 	a web-based tool that is designed to search the content of web pages and find particular information on the Internet.
 
 	section break
 	a section break splits a page into sections that can have a different format or layout within the same page in the document.
 
 	sent
 	an email folder that saves copies of emails that you have sent.
 
 	server
 	a central computer that provides information to other computers.
 
 	smartphone
 	a mobile phone that performs many of the functions of a personal computer.
 
 	social networking
 	the use of websites and other Internet services to communicate with other people.
 
 	software
 	a set of instructions or programs that tells a computer what to do or how to perform a specific task (computer software runs on hardware).
 
 	spreadsheet
 	a program that organizes data into rows and columns, also known as tabular form. This data can then be arranged, sorted, calculated (using formulas and functions), analyzed, or illustrated using graphical representations.
 
 	spyware
 	a software that secretly monitors (spies) a user’s online behaviour and gets sensitive information about a person or organization without the user’s knowledge.
 
 	supercomputer
 	a powerful computer that can process large amounts of data and do a great amount of computation very quickly.
 
 	system software
 	it is designed to run a computer's hardware and application software, and make the computer system available for use. It serves as the interface between hardware, application software, and the user.
 
 	system unit
 	the main part of a desktop computer (the case) that contains all of the main electronic components.
 
 	tab selector (tab indicator)
 	a small button located in the left corner of the horizontal ruler that supplies the user with a variety of tab marker (tab stop) options (left, right, center, etc.).
 
 	tab stop 
 	a location where the cursor (insertion point) would stop when the Tab key is pressed.
 
 	table
 	information arranged in a condensed form of columns and rows. It is a more effective way to present information.
 
 	tablet
 	a wireless touchscreen PC that is slightly smaller and weighs less than the average laptop.
 
 	text justification / alignment
 	refers to how the left and right edges of a paragraph align on a page.
 
 	touch typing
 	a method of typing (with all the available fingers) without looking at the keyboard.
 
 	trackpad
 	a small, flat surface on a laptop or other computer that does the same things as a mouse.
 
 	transistor
 	an electronic component that can be used as an amplifier or as a switch. It is used to control the flow of electricity in radios, televisions, computers, etc.
 
 	Trojan horse
 	(or Trojan) a type of malware that looks harmless but can cause harm to a computer system.
 
 	underline
 	add a line underneath the text, in order to show its importance and draw attention to the text.
 
 	URL
 	Short for Uniform Resource Locator. A web address of a specific web page or file on the Internet.
 
 	USB drive
 	a small, portable storage device used to store or transfer data for computers; often used for the storage, data backup, and transfer of computer files.
 
 	utility software
 	a type of system software that helps set up, analyze, configure, strengthen, maintain a computer and performs a very specific task (e.g. antivirus software, backup software, memory tester, screen saver, etc.).
 
 	vacuum tube
 	an electronic device that controls the flow of electrons in a vacuum. It used as a switch, amplifier, or display screen in many older model radios, televisions, computers, etc.
 
 	vertical scroll bar
 	a vertical bar on the right side of a window or screen that allows the user to scroll the window viewing area up or down.
 
 	vertical scrolling
 	sliding content up or down on a computer screen using a vertical scroll bar.
 
 	video conferencing
 	a live video-based meeting between two or more users in different locations conducted by transmitting audio and video data in real time.
 
 	VoIP
 	a telephone connection over the Internet.
 
 	word processing
 	the use of a program (software application) running on a computer to create, edit, format, and store documents.
 
 	word processor
 	a program that allows users to create, save, edit, format, print, and retrieve documents.
 
 	World Wide Web
 	a system of Internet servers that is made from millions of interlinked websites and web pages. Abbreviated as WWW or the web.
 
 	worm
 	a type of virus designed to quickly self-replicate and spread copies of itself from one computer to another.
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Answers for Self-Tests

Unit 1
 	T
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 	system unit
 	Central Processing Unit
 	temporary
 	monitor
 	Universal Serial Bus
 	hard
 	VoIP
 	letter
 	a.
 	d.
 	d.
 	b.
 	d.
 	a.
 
 Unit 2
 	T
 	F
 	F
 	T
 	Touch
 	Center
 	home
 	D
 	K
 	d.
 	d.
 	b.
 	c.
 	d.
 	b.
 	c.
 
 Unit 3
 	T
 	F
 	T
 	F
 	hard
 	VoIP
 	letter
 	folder
 	printer
 	edit
 	c.
 	d.
 	b.
 	c.
 
 Unit 4
 	F
 	T
 	T
 	F
 	web browser
 	bar
 	PDF
 	d.
 	c.
 	d.
 
 Unit 5
 	F
 	T
 	T
 	F
 	T
 	hacker
 	virus
 	worm
 	spyware
 	invisible
 	Inbox
 	Deleted
 	a.
 	d.
 	b.
 	c.
 
 Unit 6
 	T
 	F
 	F
 	T
 	F
 	T
 	F
 	Word processor
 	spreadsheet
 	Presentation
 	Mainframe
 	network
 	webpages
 	Cookie
 	Operating system
 	d.
 	d.
 	c.
 	b.
 	a.
 	d.
 	b.
 	d.
 
 Unit 7
 	T
 	F
 	F
 	T
 	F
 	F
 	T
 	T
 	transistor
 	CPU
 	Machine language
 	AI
 	machine
 	input
 	System
 	device
 	d.
 	c.
 	b.
 	d.
 	a.
 	c.
 
 Unit 8
 	F
 	T
 	F
 	T
 	F
 	F
 	F
 	touchpad
 	left
 	touch
 	drop
 	output
 	icons
 	hierarchy
 	b.
 	c.
 	b.
 	a.
 	d
 	d.
 	d.
 	b.
 
 Unit 9
 	F
 	F
 	T
 	T
 	F
 	F
 	T
 	Word processing
 	I-beam
 	original
 	printer
 	appearance
 	Center
 	right
 	underneath
 	help
 	b.
 	b.
 	c.
 	d.
 	a.
 	c.
 
 Unit 10
 	T
 	F
 	T
 	F
 	F
 	header
 	bullet
 	vertical
 	section
 	b.
 	c.
 	d.
 	b.
 	d.
 	a.
 
 Unit 11
 	F
 	F
 	T
 	T
 	F
 	T
 	T
 	bookmark
 	bar
 	star
 	e-mail
 	Cc
 	sent
 	search engine
 	hacker
 	Malware
 	virus
 	spyware
 	c.
 	d.
 	b.
 	c.
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